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r a Class B digital device, pursuant
sonable protection against harmful
es and can radiate radio frequency
s, may cause harmful interference
ence will not occur in a particular
 or television reception, which can
ed to try to correct the interference

ich the receiver is connected.
for help.

autioned that changes or modifica-
ove standards could void your au-
FCC Statement
(Federal Communications Commission)
This equipment has been tested and found to comply with the limits fo
to Part 15 of the FCC Rules. These limits are designed to provide rea
interference in a residential installation. This equipment generates, us
energy and, if not installed and used in accordance with the instruction
to radio communications. However, there is no guarantee that interfer
installation. If this equipment does cause harmful interference to radio
be determined by turning the equipment off and on, the user is encourag
by one or more of the following measures:

• Re orient or relocate the receiving antenna.
• Increase the separation between the equipment and receiver.
• Connect the equipment into an outlet on a circuit different from that to wh
• Consult the service representative or an experienced radio/TV technician 

Warning
Use only shielded cables to connect I/O devices to this equipment. You are c
tions not expressly approved by the manufacturer for compliance with the ab
thority to operate the equipment.
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TIONS
d always be followed to reduce the
g:

h bowl, kitchen sink or laundry tub, 

ical storm. There may be a remote 

k.
t dispose of batteries in a fire. They 

structions.

icing or disassembling this equip-

. 26 AWG OR LARGER, 
ORD
IMPORTANT SAFETY INSTRUC
When using your telephone equipment, basic safety precautions shoul
risk of fire, electric shock and injury to persons, including the followin

1. Do not use this product near water, for example near a bath tub, was
in a wet basement or near a swimming pool.

2. Avoid using a telephone (other than a cordless type) during an electr
risk of electrical shock from lightning.

3. Do not use the telephone to report a gas leak in the vicinity of the lea
4. Use only the power cord and batteries indicated in this manual. Do no

may explode. Check with local codes for possible special disposal in

CAUTION
Always disconnect all telephone lines from the wall outlet before serv
ment.

TO REDUCE THE RISK OF FIRE, USE ONLY NO
TELECOMMUNICATION LINE C
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vent this, follow these suggestions:

se and the components could be 

 power supply away from any kind 
 other liquid gets into it, the com-

ot place anything heavy 
e computer.

 com-
ironment.

Do not place the computer on 
any surface which will block 
the vents.
Instructions for Care and Operation
The notebook computer is quite rugged, but it can be damaged. To pre

1. Don’t drop it, or expose it to shock. If the computer falls, the ca
damaged.

2. Keep it dry, and don’t overheat it, and. Keep the computer and
of heating element. This is an electrical appliance. If water or any
puter could be badly damaged.

Do not expose the computer 
to any shock or vibration.

Do not place it on an unstable 
surface.

Do n
on th

Do not expose it to excessive 
heat or direct sunlight.

Do not leave it in a place 
where foreign matter or mois-
ture may affect the system.

Don’t use or store the
puter in a humid env
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transformers, electric motors, and 
e and damage your data.

t the computer down properly and 
ur data as data may be lost if the 

he com- Perform routine maintenance 
on your computer.

rd before 
 devices.
3. Avoid interference. Keep the computer away from high capacity 
other strong magnetic fields. These can hinder proper performanc

4. Follow the proper working procedures for the computer. Shu
don’t forget to save your work. Remember to periodically save yo
battery is depleted.

5. Take care when using peripheral devices.

Do not turn off the power 
until you properly shut down 
all programs.

Do not turn off any peripheral 
devices when the computer is 
on.

Do not disassemble t
puter by yourself.

Use only approved brands of 
peripherals.

Unplug the power co
attaching peripheral



V

Preface

ith this computer.
tional travel but it still requires a 

e unsure of your local power specifi-
r local power company.
 or a 3-prong grounded plug. The 

 not defeat its purpose. If you do not 
alified electrician install one.
sure to disconnect it by the plug head, 

(s) you use can support the total cur-

 disconnected from any external 

r cord if Do not place heavy objects 
on the power cord.
I

Power Safety
The computer has specific power requirements:

• Only use a power adapter approved for use w
• Your AC adapter may be designed for interna

steady, uninterrupted power supply. If you ar
cations, consult your service representative o

• The power adapter may have either a 2-prong
third prong is an important safety feature; do
have access to a compatible outlet, have a qu

• When you want to unplug the power cord, be 
not by its wire.

• Make sure the socket and any extension cord
rent load of all the connected devices.

• Before cleaning the computer, make sure it is
power supplies.

Do not plug in the power 
cord if you are wet.

Do not use the powe
it is broken.

Power Safety 
Warning

Before you undertake
any upgrade proce-
dures, make sure that
you have turned off the
power, and discon-
nected all peripherals
and cables (including
telephone lines). It is
advisable to also re-
move your battery in
order to prevent acci-
dentally turning the
machine on.
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y explode, leak or damage the com-

may make the battery explode.
ement to your service representative 

ways dispose of batteries carefully. 
 discarded.

 battery is recyclable. At the end of
e of this battery into the municipal
rea for recycling options or proper

me or equivalent type recommend-
’s instructions.
Battery Precautions
• Only use batteries designed for this computer. The wrong battery type ma

puter.
• Recharge the batteries using the notebook’s system. Incorrect recharging 
• Do not try to repair a battery pack. Refer any battery pack repair or replac

or qualified service personnel.
• Keep children away from, and promptly dispose of a damaged battery. Al

Batteries may explode or leak if exposed to fire, or improperly handled or
• Keep the battery away from metal appliances.
• Affix tape to the battery contacts before disposing of the battery.
• Do not touch the battery contacts with your hands or metal objects.

Battery Disposal
The product that you have purchased contains a rechargeable battery. The
its useful life, under various state and local laws, it may be illegal to dispos
waste stream. Check with your local solid waste officials for details in your a
disposal.

Caution
Danger of explosion if battery is incorrectly replaced. Replace only with the sa
ed by the manufacturer. Discard used battery according to the manufacturer
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part of the computer.

 your warranty and expose you and
e personnel. Unplug the computer
nel under any of the following con-

structions.
s liquid if the LCD panel breaks).
III

Cleaning
Do not apply cleaner directly to the computer, use a soft clean cloth. 
Do not use volatile (petroleum distillates) or abrasive cleaners on any 

Servicing
Do not attempt to service the computer yourself. Doing so may violate
the computer to electric shock. Refer all servicing to authorized servic
from the power supply. Then refer servicing to qualified service person
ditions:

• When the power cord or AC/DC adapter is damaged or frayed.
• If the computer has been exposed to rain or other liquids.
• If the computer does not work normally when you follow the operating in
• If the computer has been dropped or damaged (do not touch the poisonou
• If there is an unusual odor, heat or smoke coming from your computer.
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stem is ready to go:

 bag. 
 need a second voltage adapter. 
ket adapters.
traps.
mera), pack them and those 

ns or require proof of ownership 
dy (it may be useful to have the 
Travel Considerations
Packing
As you get ready for your trip, run through this list to make sure the sy

1. Check that the battery pack and any spares are fully charged.
2. Power off the computer and peripherals.
3. Close the display panel and make sure it’s latched.
4. Disconnect the AC adapter and cables. Stow them in the carrying
5. The AC adapter uses voltages from 100 to 240 volts so you won’t

However, check with your travel agent to see if you need any soc
6. Put the notebook in its carrying bag and secure it with the bag’s s
7. If you’re taking any peripherals (e.g. a printer, mouse or digital ca

devices’ adapters and/or cables.
8. Anticipate customs - Some jurisdictions may have import restrictio

for both hardware and software. Make sure your “papers” are han
computer in a sleep mode before going through customs).
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face, and Chapter 8: Troubleshoot-

t. In some areas, computer theft is
rs may not be sufficiently careful.

& X-ray machines can damage the
estroy any stored data - Pass your
inspect them (you may be asked to

rs and other electronic devices in
 the notebook in an overhead com-
n the compartment is opened.

he AC adapter and keep your bat-

ater vapor can condense inside the
e can evaporate.
On the Road
In addition to the general safety and maintenance suggestions in this pre
ing, keep these points in mind:

Hand-carry the notebook - For security, don’t let it out of your sigh
very common. Don’t check it with “normal” luggage. Baggage handle
Avoid knocking the computer against hard objects.

Beware of Electromagnetic fields - Devices such as metal detectors 
computer, hard disk, floppy disks, and other media. They may also d
computer and disks around the devices. Ask security officials to hand-
turn it on). Note: Some airports also scan luggage with these devices.

Fly safely - Most airlines have regulations about the use of compute
flight. These restrictions are for your safety, follow them. If you stow
partment, make sure it’s secure. Contents may shift and/or fall out whe

Get power where you can - If an electrical outlet is available, use t
tery(ies) charged.

Keep it dry - If you move quickly from a cold to a warm location, w
computer. Wait a few minutes before turning it on so that any moistur
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t of the computer for long periods
jury from repetitive strain to your
 strain:

htly 
 relaxed 

n the 

bly.
gree 

e.

time. Fre-
Developing Good Work Habits
Developing good work habits is important if you need to work in fron
of time. Improper work habits can result in discomfort or serious in
hands, wrists or other joints. The following are some tips to reduce the

• Adjust the height of the chair and/or desk so that the keyboard is at or slig
below the level of your elbow. Keep your forearms, wrists, and hands in a
position.

• Your knees should be slightly higher than your hips. Place your feet flat o
floor or on a footrest if necessary.

• Use a chair with a back and adjust it to support your lower back comforta
• Sit straight so that your knees, hips and elbows form approximately 90-de

angles when you are working.
• Take periodic breaks if you are using the computer for long periods of tim

Remember to:
• Alter your posture frequently.
• Stretch and exercise your body several times a day.
• Take periodic breaks when you work at the computer for long periods of 

quent and short breaks are better than fewer and longer breaks.
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 strain and muscle fatigue in your

r outside sources of light.
 that allow you to see the screen 

nce.
II

Lighting
Proper lighting and comfortable display viewing angle can reduce eye
neck and shoulders.

• Position the display to avoid glare or reflections from overhead lighting o
• Keep the display screen clean and set the brightness and contrast to levels

clearly.
• Position the display directly in front of you at a comfortable viewing dista
• Adjust the display viewing angle to find the best position.



XIII

Preface

 ...................................................... 1-7
e .................................................... 1-7
 & Communication Indicators ..... 1-7
 Indicators .................................... 1-7
ttons ............................................ 1-8

r Switch ....................................... 1-8
on ................................................. 1-8
....................................................... 1-9

 Buttons ...................................... 1-9
..................................................... 1-10
 1394 Port ................................... 1-10
t Port ........................................... 1-10
e-In Jack ..................................... 1-11
-Out Jack .................................... 1-11
nsceiver ..................................... 1-11
odule ON/OFF Switch ............... 1-12
kers ............................................ 1-12

..................................................... 1-13
 Bay ............................................ 1-13
rt ................................................ 1-14

Floppy Disk Drive) .................... 1-14
ot ................................................ 1-14
..................................................... 1-15
ck Slot ....................................... 1-15
..................................................... 1-16
Contents
Notice ........................................................................ I

Trademarks ....................................................... I
FCC Statement ................................................ II
Instructions for Care and Operation .............. IV
Power Safety .................................................. VI
Battery Precautions ....................................... VII
Cleaning ......................................................VIII
Servicing ......................................................VIII
Travel Considerations .................................... IX

Introduction ..................................1-1
Overview ..................................................................1-1

Advanced Users ..................................................1-1
Beginners and Not-So-Advanced Users .............1-1
Warning Boxes ...................................................1-2
Not Included .......................................................1-2
System Software .................................................1-2

Quick Start Guide .....................................................1-3
System Map ..............................................................1-4

Getting to Know Your Computer .......................1-4
Top View ..................................................................1-5

Top View with LCD Panel Open .......................1-6
PC Camera ......................................................1-7

LCD Panel
Microphon
LED Power
LED Status
Hot-Key Bu
Close Cove
Power Butt
Keyboard .
TouchPad &

Front View ........
Mini-IEEE
S/PDIF Ou
Microphon
Headphone
Infrared Tra
Wireless M
Stereo Spea

Left Side View ..
CD Device
USB 2.0 Po
3.5" FDD (
PC Card Sl

Right Side View 
Security Lo

Rear View .........



X

Preface

....................................................... 2-5
dicators ........................................ 2-5
 Communication Indicators ......... 2-6

er ................................................... 2-7
up ................................................ 2-9

..................................................... 2-10
e (FDD) ...................................... 2-11
oving Floppy Disks ................... 2-11
.................................................... 2-12
 .................................................. 2-12
 or DVDs ................................... 2-13
l Codes ....................................... 2-14
VD Regional Codes .................. 2-15

..................................................... 2-16
emoving PC Cards ................... 2-16

..................................................... 2-17
ns .............................................. 2-17
the Hot-Keys ............................. 2-17
d Numeric Keypad ..................... 2-19
eys .............................................. 2-19
eypad .......................................... 2-20
ttons/Mouse ............................... 2-21
 the TouchPad and Buttons ....... 2-21

..................................................... 2-23

..................................................... 2-23
IV

Vent ..............................................................1-16
DC-In Jack ....................................................1-16
2 * USB 2.0 Ports .........................................1-17
External Monitor (CRT) Port .......................1-17
Printer/Parallel Port ......................................1-17
Serial Port .....................................................1-17
S-Video-Out Port ..........................................1-18
PS/2 Type Port .............................................1-18
RJ-11 Phone Jack .........................................1-18
RJ-45 LAN Jack ...........................................1-18

Bottom View ..........................................................1-19
Vent ..............................................................1-19
Battery ..........................................................1-19
Hard Disk Drive ...........................................1-20
Wireless LAN (Network) Module ................1-20
Bluetooth Module .........................................1-20

Using The Computer ...................2-1
Overview ..................................................................2-1
The Power Sources ...................................................2-2

AC Adapter .........................................................2-2
Battery ................................................................2-2
Recharging the Battery with the AC Adapter .....2-3

Proper handling of the Battery Pack ..............2-3
Turning on the Computer .........................................2-4

LED Indicators ..
LED Status In
LED Power &

Auto Mail Check
Special Gro

Hard Disk Drive 
Floppy Disk Driv

Inserting/Rem
CD/DVD Device 

Loading Discs
Handling CDs
DVD Regiona

Changing D
PC Card Slot .....

Inserting and R
Hot-Keys ...........

Hot-Key Butto
Programming 

Function Keys an
Function K
Numeric K

TouchPad and Bu
Configuring

Adding a Printer 
USB Printer .



XV

Preface

 vs. Hibernate Mode .................. 3-17
..................................................... 3-18
..................................................... 3-18
e Power Button ......................... 3-19

on ................................................ 3-20
y ................................................. 3-20
 .................................................. 3-20

..................................................... 3-21
attery Power ............................... 3-21
frared Settings for FIR ............. 3-22

tilities ........................4-1
....................................................... 4-1
....................................................... 4-2
odule Drivers ............................... 4-2
iver Message ............................... 4-3
ict Message .................................. 4-3
stalling Individual Drivers .......... 4-4
ofessional .................................... 4-6
e Found ........................................ 4-6
00) ............................................... 4-7
000) ............................................. 4-7
0) ................................................. 4-7
00) ............................................... 4-7
2000) ........................................... 4-8
Install Instructions: .......................................2-23
Parallel Printer ..................................................2-24

Install Instructions: .......................................2-24

Advanced Controls ......................3-1
Overview ..................................................................3-1
Advanced Video Controls ........................................3-2

Opening the LCD ................................................3-2
Video Driver Controls ..............................................3-3

Making Adjustments for the Display ..................3-4
Display Devices ........................................................3-7

Attaching a Monitor (CRT) ................................3-7
Display Options ........................................................3-8
Enabling Other Displays ..........................................3-9

Clone Mode ......................................................3-10
Extended Desktop Mode ..................................3-10

Enabling TV Display ..............................................3-13
Power Management Features .................................3-14

Advanced Configuration and Power Interface .3-14
Enabling Power Options .........................................3-15

Conserving Power (Individual Components) ...3-16
Turn off Monitor ..........................................3-16
Turn off Hard Disk .......................................3-16

Conserving Power (System) .............................3-17
Hibernate Mode vs. Shutdown .........................3-17

Standby Mode
Standby ...
Hibernate .

Configuring th
Battery Informati

New Batter
Battery Life

Battery FAQ 
Conserving B

Configuring the In

Drivers & U
Overview ...........
What to Install ...

Optional M
Authorized Dr
Version Confl
Updating/Rein

Windows 2000 Pr
New Hardwar
Audio (Win20
Modem (Win2
LAN (Win200
Video (Win20
USB 2.0 (Win



X

Preface

lf Test (POST) ............................. 5-3
ST ................................................ 5-4
 .................................................... 5-4
rrors ............................................ 5-4

m .................................................. 5-5
 .................................................... 5-5

 ..................................................... 5-6
....................................................... 5-7
....................................................... 5-9
..................................................... 5-12
..................................................... 5-14
e Network Boot Protocol .......... 5-16

..................................................... 5-17

he Computer ...........6-1
....................................................... 6-1

pgrade ........................................ 6-2
ttery .............................................. 6-3
val Process ................................... 6-3
rd Disk Drive ............................... 6-4
grade Process ............................... 6-4
stem Memory (RAM) .................. 6-6
ade Process .................................. 6-7
 Device ...................................... 6-10
grade Process ............................ 6-10
VI

PC Card/PCMCIA (Win2000) ............................4-8
PC Camera (Win2000) .......................................4-9
Hot-Key (Win2000) ............................................4-9
TouchPad (Win2000) .........................................4-9
Wireless LAN (Win2000) ................................4-10
Bluetooth (Win2000) ........................................4-10
Auto Mail (Win2000) .......................................4-10

Windows XP ..........................................................4-11
New Hardware Found .......................................4-11
Audio (WinXP) .................................................4-12
Modem (WinXP) ..............................................4-12
LAN (WinXP) ..................................................4-12
Video (WinXP) .................................................4-13
USB 2.0 (WinXP) .............................................4-13
PC Card/PCMCIA (WinXP) ............................4-13
PC Camera (WinXP) ........................................4-14
Hot-Key (WinXP) .............................................4-14
TouchPad (WinXP) ..........................................4-14
Wireless LAN (WinXP) ...................................4-15
Bluetooth (WinXP) ...........................................4-15
Auto Mail (WinXP) ..........................................4-15

BIOS Utilities ...............................5-1
Overview ..................................................................5-1
Important BIOS Settings ..........................................5-2

The Power-On Se
Failing the PO

Fatal Errors
Non-Fatal E

The Setup Progra
Entering Setup
Setup Screens

Main Menu ........
Advanced Menu 
Security Menu ...
Boot Menu ........

Configuring th
Exit Menu .........

Upgrading T
Overview ...........

When Not to U
Removing the Ba

Battery Remo
Upgrading the Ha

Hard Disk Up
Upgrading the Sy

Memory Upgr
Upgrading the CD

CD Device Up



XVII

Preface

t Password .................................. 8-11
e ................................................. 8-12
..................................................... 8-13
..................................................... 8-14
..................................................... 8-15
use ............................................. 8-16

..................................................... 8-17

..................................................... 8-18
Bluetooth Modules .................... 8-19
 .................................................. 8-20

 Notes ......................................... 8-21

. Specifications A-1
................................................... A-1
................................................... A-1
................................................... A-1
................................................... A-2
................................................... A-2
................................................... A-2
................................................... A-2
................................................... A-2
.................................................. A-3

................................................... A-3

................................................... A-3
Upgrading the Processor ........................................6-12

Optional Modules .........................7-1
Overview ..................................................................7-1
Wireless LAN & Bluetooth Modules .......................7-2

Wireless LAN Driver Installation (Win2000) ....7-3
Wireless LAN Driver Installation (WinXP) .......7-4
Bluetooth Driver Installation (Win2000) ...........7-5
Bluetooth Driver Audio Setup (Win2000) .........7-6
Bluetooth Driver Installation (WinXP) ..............7-7
Control Panel Options (Bluetooth) .....................7-8

PC Camera ..............................................................7-10
PC Camera Driver Installation (Win2000) .......7-11
PC Camera Driver Installation (WinXP) ..........7-12

Audio Setup ..................................................7-13
AMCAP ........................................................7-15

Troubleshooting ...........................8-1
Overview ..................................................................8-1
Basic Hints and Tips ................................................8-2
Backup and General Maintenance ............................8-3
Viruses ......................................................................8-4
Upgrading and Adding New Hardware/Software ....8-5
Power ........................................................................8-7
Display .....................................................................8-9

Hard Disk & Boo
Floppy Disk Driv
Audio ................
CD Device .........
PC Card .............
Keyboard and Mo
Printer ................
Operation ..........
Wireless LAN & 
Driver Installation
Hyper-Threading

Appendix A
Processor ..........
Core Logic .......
Structure ...........
Security ............
Memory ............
BIOS ................
LCD Options ....
Display .............
Storage Devices 
Audio ................
PC Card ............



X

Preface
VIII

Interface ............................................................... A-4
Communication ................................................... A-4
Power Management ............................................. A-4
Power ................................................................... A-5
Indicators ............................................................. A-5
Environmental Spec ............................................ A-5
Physical Dimensions ........................................... A-5
Weight ................................................................. A-5
Optional ............................................................... A-5



Overview 1 - 1

1Introduction

n your
e or all

wever
“BIOS
1. You

f them)
 if you
d refer
d with

Notes

Check the light colored
boxes with the mark
above to find detailed
information about the
computer’s features. 
Chapter 1: Introduction
Overview
This manual refers to the hardware and essential software required to ru
notebook computer. Depending on how your system is configured, som
of the features described may already be set up. This chapter covers:

• The Manual — how to use it
• System Map — navigating around your computer

Advanced Users
If you are an advanced user you may skip over most of this manual. Ho
you may find it useful to refer to the “What to Install” on page 4 - 2, 
Utilities” on page 5 - 1 and “Upgrading The Computer” on page 6 - 
may also find the notes marked with a  of interest to you.

Beginners and Not-So-Advanced Users
If you are new to computers (or do not have an advanced knowledge o
then you should try to look through all the documentation. Do not worry
do not understand everything the first time. Keep this manual nearby an
to it to learn as you go. You may find it useful to refer to the notes marke
a  as indicated in the margin.
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1

l attention to the warning and safe-
l. Also please note the safety and
eface.

ofessional, Windows XP etc.) have
. word processing, spreadsheet and
about the operating systems or pro-
manuals.

stem software pre-installed. Where
nfiguring your computer for a dif-
fers to the following operating sys-
- 2 Overview

Warning Boxes
No matter what your level please pay carefu
ty information indicated by the  symbo
handling instructions as indicated in the Pr

Not Included
Operating Systems (e.g. Windows 2000 Pr
their own manuals, as do applications (e.g
database programs). If you have questions 
grams then please consult the appropriate 

System Software
Your computer may already come with sy
this is not the case, or where you are re-co
ferent system, you will find this manual re
tems:

• Microsoft Windows 2000
• Microsoft Windows XP
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an tell
t com-

 pages,

is any-
 before

e ready
nstruc-

Cards.
.g. 

see 
utlet, 

Peripheral Devices

Please note that pe-
ripherals (printers, dig-
ital cameras, etc.)
which attach to your
computer by either
USB or IEEE1394
ports may be connect-
ed after Windows is
up and running. All oth-
er peripherals must be
connected before you
turn on the system.
Quick Start Guide
This guide assumes that you are already familiar with computers and c
at a glance what and where all the key components are. If you are not tha
fortable with this type of device, then please refer to the following
which give an overview of the system.

It is still best to review these steps, before taking any action. If there 
thing you are not sure about, then please refer to the appropriate chapter
continuing.

Unless you need to install an operating system, your computer should b
to work right out of the box. Before you begin please follow the safety i
tions in the Preface.

1. Remove all packing materials, CDs/DVDs, floppy disks, and any PC 
2. Securely attach any peripherals you want to use with the notebook (e

keyboard and mouse) to their ports.
3. Attach the AC adapter to the DC-in jack at the rear of the computer (

“Rear View” on page 1 - 16), then plug the AC power cord into an o
and connect the AC power cord to the AC adapter.

4. Raise the lid/LCD to a comfortable viewing angle.
5. Press the power button to turn “on”.
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1

. Most of these are enabled by your
he various subsystems are covered

er
come familiar with the basic func-
ous ports and components of your

Design II
- 4 System Map

System Map
Your computer has a lot of built-in features
operating system. Further explanations of t
in the chapter or pages indicated.

Getting to Know Your Comput
The following graphics will help you to be
tions, and to learn the location of the vari
computer.

Design Differences

This manual refers to
the two notebook de-
signs pictured on this
page.

The designs vary
slightly in external de-
sign. Photographs
used throughout this
manual are of Design I.

Figure 1 - 1
Design Differences

Design I
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 top 
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Figure 1 - 2
Top View with LCD 

Panel Closed

1. LCD Latches
2. LED Power & 

Communication 
Indicators
Top View

To open the LCD display:
1. Place the computer on a stable surface.
2. Move the LCD latches  in the direction of the arrows to release the

cover.
3. Lift the top cover to reveal the LCD panel and keyboard.
4. Adjust the LCD panel to a comfortable viewing angle.
5. The LED indicators  show the power and battery status of the com

give notification of e-mail received, and the power status of wireless 
modules.

1

2

1

1

2
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- 6 Top View

Top View with LCD Panel Open
Figure 1 - 3

Top View with LCD 
Panel Open

1. Optional PC 
Camera

2. LCD
3. Built-In Microphone
4. LED Power & 

Communication 
Indicators

5. LED Status 
Indicators

6. Hot-Key buttons
7. Close Cover Switch
8. Power Button
9. Keyboard
10. TouchPad and 

Buttons

2

4

5

1

3

9

10
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PC Camera
If you have purchased the optional PC Camera, make sure to install th
ware application (see “PC Camera” on page 7 - 10).

LCD Panel
The computer comes with a 14.1" OR a 15.0" TFT (Liquid Crystal D
screen, depending upon the configuration purchased. See “LCD Optio
page  A - 2 for details.

Microphone
Record on your notebook computer with the built-in microphone.

LED Power & Communication Indicators
These indicators display the system power status, and battery status
computer. The third indicator may be configured to give a visual confir
when e-mail is received in the default e-mail program (see “LED Po
Communication Indicators” on page 2 - 6).

LED Status Indicators
These display the system’s operational status. Refer to “LED Status I
tors” on page 2 - 5 for more information on what the lights mean.
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s to your default Internet browser,
 of your choice. To learn how to set
7.

e LCD Panel is closed. When this
setting of your operating system’s
wer saving state (see Figure 3 - 13

on or off (see “Turning on the
y also be used as a suspend/resume
management control panel of your
ower Button” on page 3 - 19).
- 8 Top View

Hot-Key Buttons
The three hot-keys allow you instant acces
default e-mail program, and an application
the buttons, see “Hot-Keys” on page 2 - 1

Close Cover Switch
This switch acts as a sensor to tell when th
LCD cover sensor is activated the default 
power scheme sends the computer into a po
on page 3 - 19).

Power Button
Press this button to turn your computer 
Computer” on page 2 - 4). This button ma
key, once configured as such in the power 
operating system (see “Configuring the P

Shutdown

Please note that you
should always shut
your computer down
by choosing the Shut
Down/Turn Off Com-
puter command from
the Start menu in Win-
dows. This will help
prevent hard disk or
system problems.
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Forced Off

If the system “hangs”,
and the Ctrl + Alt + Del
key combination
doesn’t work, press the
power button for 4 sec-
onds, or longer, to
force the system to
turn itself off.
Keyboard
The computer has a “Win Key” keyboard including a numeric keypad
the same features as a full-sized desktop keyboard and can easily be re
with a different language keyboard should you desire.

TouchPad & Buttons
The pointing device features a sensitive glide pad for precise movem
functions the same way as a two-button mouse. The right TouchPad bu
the same as the right mouse button; the left TouchPad button is the s
the left mouse button. The central button may be used to scroll up and
or may be configured to perform a variety of functions (see “Configur
TouchPad and Buttons” on page 2 - 21). 
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ce Format) Out Port allows you to
AC-3 compatible receiver for “5.1”

6 7

1

8

ERED IEEE 1394 devices.
- 10 Front View

Front View

Mini-IEEE 1394 Port
This allows high-speed connection to vario
disk drives and digital cameras (see note a

S/PDIF Out Port
This S/PDIF (Sony/Philips Digital Interfa
connect your DVD-capable PC to a Dolby 
or ‘dts’ surround sound.

Figure 1 - 4
Front View

1. LCD Latches
2. Mini-IEEE 1394 

Port
3. S/PDIF Out Port
4. Microphone-In Jack
5. Headphone-Out 

Jack
6. Infrared 

Transceiver
7. Wireless Module 

ON/OFF Switch
8. Built-In Speakers

4 5

1

2 3

8

IEEE 1394

The IEEE 1394 port only supports SELF POW
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- 22).

Infrared 
Communication

The Infrared transceiv-
er operates on a “Line
of Sight”.

Make sure nothing is
blocking the “Line of
Sight” between your
system’s transceiver
and the destination’s
transceiver.
Microphone-In Jack
Record on your notebook computer with an external microphone.

Headphone-Out Jack
Headphones may be connected through this jack. Note: Set your system
ume to a reduced level before connecting to this jack.

Infrared Transceiver
The infrared transceiver enables communication between the compu
another similarly equipped device, and is 4M bps FIR, IrDA 1.1 com
For further information please refer to the manual of the device you w
connect (see “Configuring the Infrared Settings for FIR” on page 3 
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b Wireless LAN and/or Bluetooth
the module(s) ON or OFF. To en-
ll the drivers/software for it/them.
12 to toggle through the options if
eless LAN & Bluetooth Modules”
unication Indicators” on page 2 -

sound.

 Conflict

module and the Bluetooth module at
cation conflict.
- 12 Front View

Wireless Module ON/OFF Switch
If you have purchased the optional 802.11
module(s), you can use this switch to turn 
able the module(s) you will need to insta
You can use the key combination Fn + F
you have two modules installed (see “Wir
on page 7 - 2 and “LED Power & Comm
6).

Stereo Speakers
Two built-in speakers provide rich, stereo 

Wireless Device 
Operation Aboard 

Aircraft

The use of any porta-
ble electronic trans-
mission devices
aboard aircraft is usu-
ally prohibited. Make
sure the modules are
OFF if you are using
the computer aboard
aircraft.  Communication

Do not try to use the 802.11b Wireless LAN 
the same time, as this may cause a communi
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Figure 1 - 5
Left Side View

1. CD Device Bay
2. USB 2.0 Port
3. Floppy Disk Drive
4. PC Card Slot
5. PC Card Slot Eject 

Button

rrup-
eject
ome
Left Side View

CD Device Bay
A 5.25" CD-ROM drive, or DVD-ROM drive, or CD-RW, or Comb
CD-RW or DVD-ROM Drive, or DVD-RW (12.7mm height) is stand
pending on the model you purchased. For more information on using th
please refer to “CD/DVD Device” on page 2 - 12.

3

4

1

52

CD Emergency Eject

If you need to manually eject a CD/DVD (e.g. due to an unexpected power inte
tion) you may push the end of a straightened paper clip into the emergency 
hole. Do not use a sharpened pencil or similar object that may break and bec
lodged in the hole.
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is fully USB 1.1 compliant) is for
, mice or scanners, and for high-
igital video cameras or high-speed
the computer, and unplugged from
 system off (if the power rating of
ke sure you use the power supply

rive. For more information please
ge 2 - 11.

pe-II PC card (PC cards were also
lly supports Cardbus. Refer to “PC
ation.
- 14 Left Side View

USB 2.0 Port
This USB 2.0 compatible port (USB 2.0 
low-speed peripherals such as keyboards
speed peripherals such as external HDDs, d
scanners etc. Devices can be plugged into 
the computer, without the need to turn the
your USB device is 500mA or above, ma
which comes with the device).

3.5" FDD (Floppy Disk Drive)
This is a 3.5", 1.44 MB fixed floppy disk d
refer to “Floppy Disk Drive (FDD)” on pa

PC Card Slot
The 3.3V/3.5V slot may be used for a Ty
previously referred to as PCMCIA) and fu
Card Slot” on page 2 - 16 for more inform

Media Warning

Don’t try to remove a
floppy disk while the
system is accessing it.
This may cause the
system to “crash”.
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Figure 1 - 6
Right Side View

1. Security Lock Slot
Right Side View

Security Lock Slot
To prevent possible theft, a Kensington-type lock can be attached to th
Locks can be purchased at any computer store.
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ok from overheating.

 to power your notebook.

5 6 7 8 9 10

Overheating

To prevent your com-
puter from overheating
make sure nothing
blocks the vent/fan
outlet while the com-
puter is in use.
- 16 Rear View

Rear View

Vent
This enables airflow to prevent the notebo

DC-In Jack
Plug the supplied AC adapter into this jack

Figure 1 - 7
Rear View

1. Vent
2. DC-In Jack 
3. 2 * USB Ports
4. External Monitor 

(CRT) Port
5. Parallel Port
6. Serial Port
7. S-Video-Out Port
8. PS/2 Type Port
9. RJ-11 Phone Jack
10. RJ-45 LAN Jack

3
41

2
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isplay

ed Par-
2 * USB 2.0 Ports
These USB 2.0 compatible ports (USB 2.0 is fully USB 1.1 compliant)
low-speed peripherals such as keyboards, mice or scanners, and fo
speed peripherals such as external HDDs, digital video cameras or high
scanners etc. Devices can be plugged into the computer, and unplugge
the computer, without the need to turn the system off (if the power ra
your USB device is 500mA or above, make sure you use the power 
which comes with the device).

External Monitor (CRT) Port
Connect an external VGA monitor (CRT) to this port to allow dual v
simultaneous display on the LCD and external VGA monitor (see “D
Devices” on page 3 - 7).

Printer/Parallel Port
This port supports ECP (Extended Capabilities Port) and EPP (Enhanc
allel Port).

Serial Port
Connect a serial type mouse to this port.
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nd view DVDs, VCDs or anything
eed an S-Video cable to make the

 driver controls (see “Enabling TV

eyboard to this port. You can use a

ou may plug the telephone line di-
.

ually connect to the LAN port.

ns.
ually connect to the LAN port.
- 18 Rear View

S-Video-Out Port
Connect your television to your computer a
else your computer can display. You will n
connection. Enable this port from the video
Display” on page 3 - 13).

PS/2 Type Port
Connect an external PS/2 type mouse or k
“Y” splitter if you want to attach both.

RJ-11 Phone Jack
This port connects to the built-in modem. Y
rectly into this RJ-11 telephone connection
Note: Broadband (e.g. ADSL) modems us

RJ-45 LAN Jack
This port supports LAN (Network) functio
Note: Broadband (e.g. ADSL) modems us
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Figure 1 - 8
Bottom View

1. Vent/Fan Outlets 
2. Battery Cover
3. Hard Disk Cover
4. Bluetooth Module 

Cover
5. CPU & Memory 

Socket Cover

Note: The RAM and option-
al Wireless LAN module are
located under the CPU Heat-
sink Cover

ser
art.
art-
 the

ay
ty.

Overheating

To prevent your com-
puter from overheating
make sure nothing
blocks the vent/fan
outlet while the com-
puter is in use.
Bottom View

Vent
This enables airflow to prevent the notebook from overheating.

Battery
See “Battery Information” on page 3 - 20 for instructions on battery u
care.

1
1

2

4

5

3

CPU

The CPU is not a u
serviceable p
Opening this comp
ment, or accessing
CPU in any way, m
violate your warran
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 your data. See information on page
ng your hard disk drive.

I 802.11b Wireless LAN module,
xternally visible (please check with
uration includes the Wireless LAN
 sidebar note).

oth module, the antenna and other
ase check with your service repre-
he Bluetooth module, make sure to

ing

 the system is on. This could cause
r tampering with the HDD may violate
r service representative.
- 20 Bottom View

Hard Disk Drive
The internal hard disk drive is used to store
6 - 4 for information on upgrading/replaci

Wireless LAN (Network) Module
If your computer has the optional mini PC
the antenna and other components are not e
your service representative). If your config
module, make sure to install the driver (see

Bluetooth Module
If your computer has the optional Blueto
components are not externally visible (ple
sentative). If your configuration includes t
install the software (see sidebar note).

Drive Warn

Don’t try to remove the hard disk (HDD) while
data loss or damage. Unauthorized removal o
your warranty. If you are in doubt, consult you

Wireless LAN & 
Bluetooth Modules

The Wireless LAN and
Bluetooth modules
may be enabled and
disabled by the switch
at the front of the com-
puter (see “Wireless
Module ON/OFF
Switch” on page 1 -
12).

If you have both op-
tional wireless mod-
ules in your computer,
you can use the Fn +
F12 key combination
to toggle power to the
modules (see “Wire-
less LAN & Bluetooth
Modules” on page 7 -
2).
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Chapter 2: Using The Compute
Overview
To learn more about using your computer, please read this chapter.

This chapter includes:

• The Power Sources
• Turning on the Computer
• The LED Indicators
• The Auto Mail Program
• The Hard Disk Drive
• The Floppy Disk Drive
• The CD/DVD Device
• The PC Card Slot
• The Hot-Keys
• The Function Keys & Numeric Keypad
• The TouchPad & Buttons/Mouse
• Adding a Printer (general guidelines)
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 AC adapter or a battery pack.

your computer. The wrong type of
 its components. 

 at the rear of the computer.
hen connect the AC power cord to 

ing angle.

ok computer while you are on the
attery life varies depending on the
ing. To increase battery life, let the
ging. 

e battery. For more information on
ation” on page 3 - 20.
- 2 The Power Sources

The Power Sources
The computer can be powered by either an

AC Adapter
Use only the AC adapter that comes with 
AC adapter will damage the computer and

1. Attach the AC adapter to the DC-in jack
2. Plug the AC power cord into an outlet, t

the AC adapter.
3. Raise the lid/LCD to a comfortable view
4. Press the power button to turn “on”.

Battery
The battery allows you to use your notebo
road or an electrical outlet is unavailable. B
applications and the configuration you're us
battery discharge completely before rechar

We recommend that you do not remove th
the battery, please refer to “Battery Inform

Power Button as 
Standby or Hibernate 

Button

If you are using a fully
ACPI-compliant OS,
(such as Windows
2000 Professional, or
Windows XP) you can
use the OS’s “Power
Options” control panel
to set the power button
to send the system into
Standby or Hibernate
mode (see your OS’s
documentation, or
“Configuring the
Power Button” on
page 3 - 19 for de-
tails).
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 Battery Removal

We recommend that
you do not remove the
battery yourself.
Please consult your
service representative
should you need to re-
move the battery for
any reason.

Low Battery Warning

When the battery is
critically low, immedi-
ately connect the AC
adapter to the comput-
er or save your work,
otherwise, the un-
saved data will be lost
when the power is de-
pleted.
Recharging the Battery with the AC Adapter
The battery pack automatically recharges when the AC adapter is attach
plugged into an electrical outlet. If the computer is powered on, and in
will take several hours to fully recharge the battery. When the comp
turned off but plugged into an electrical outlet, battery charge time is les
fer to “LED Indicators” on page 2 - 5 for information on the battery 
status, and to “Battery Information” on page 3 - 20 for more informa
how to maintain the battery pack.)

Proper handling of the Battery Pack
• DO NOT disassemble the battery pack under any circumstances
• DO NOT expose the battery to fire or high temperatures, it may exp
• DO NOT connect the metal terminals (+, -) to each other
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mputer. To turn it on simply press

 power button as a Standby/Hiber-
 pressed for less than 4 seconds
 longer than this will shut the com-
indows control panel to configure

ff

 key combination doesn’t work, press
 force the system to turn itself off.
- 4 Turning on the Computer

Turning on the Compute
Now you are ready to begin using your co
the power button on the front panel.

When the computer is on, you can use the
nate/Shutdown hot-key button when it is
(pressing and holding the power button for
puter down). Use Power Options in the W
this feature.

Shutdown

Note that you should
always shut your com-
puter down by choos-
ing the Shut Down/
Turn Off Computer
command from the
Start menu in Win-
dows. This will help
prevent hard disk or
system problems.

Forced O

If the system “hangs”, and the Ctrl + Alt + Del
the power button for 4 seconds, or longer, to
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Figure 2 - 1
LED Indicators

Scroll Lock

To enable and disable
the Scroll Lock feature,
press the Fn and
ScrLk keys simultane-
ously.

Table 2 - 1
LED Status 
Indicators
LED Indicators
There are two sets of LED indicators (LED Power & Communication
cators and LED Status Indicators) on your computer that will displa
ful information about the current status of the computer. The LED Po
Communication Indicators are also visible when the top of your co
is closed.

LED Status Indicators
Icon Color Description

Green Floppy/Hard disk/CD Device activity

Green Number Lock is activated

Green Caps Lock is activated

Green Scroll Lock is activated (to activate press Fn & S

Power & Communication Indicators LED Status Indicators
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2 Indicators
Description

The computer is on

omputer is in standby mode 

 battery is being charged

e battery is fully charged

s reached critically low power status

as a serious problem (see sidebar)

New mail has arrived

rived from users defined in the Special 
oup in Auto Mail Checker

nal) Wireless LAN module is On

tional) Bluetooth module is On

tional) Wireless LAN and Bluetooth 
ules are On (see sidebar)
- 6 LED Indicators

LED Power & Communication 
Icon Color

Green

Blinking Green The c

Orange The

Green Th

Blinking Orange The battery ha

Blinking Half 
Orange/ Half 

Green
 The battery h

Blinking Green

Fast Blinking 
Green

New mail has ar
Gr

Green The (optio

Orange The (op

Half Orange/Half 
Green

Both the (op
mod

 Battery Problem

If the battery has a se-
rious problem contact
your service represen-
tative.

 Communication 
Conflict

Do not try to use the
802.11b Wireless LAN
module and the Blue-
tooth module at the
same time, as this may
cause a communica-
tion conflict.

Table 2 - 2
LED Power & 

Communication 
Indicators
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Figure 2 - 2
Auto Mail Checker 

(Startup Menu)
Auto Mail Checker
After you have installed the driver for the Auto Mail program (see “W
Install” on page 4 - 2) you may then configure it to give you notificatio
you receive new mail. You must be online to receive this notificatio
that this program only supports the POP3 protocol), and your defau
program does not need to be open.

The Auto Mail Checker appears as an icon  in the taskbar. Clicking
icon will bring up the following options menu. (If you have not inpu
mail account data, then you will be prompted to do so.)

Select Open to bring up the control panel for the program.
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r mailserver, name, password, pro-
- 8 Auto Mail Checker

You may then configure the options for you
gram and method(s) of notification.

Note

Check with your Inter-
net Service Provider,
network administrator
or Mail Service provid-
er for details on what to
put on these pages.

Figure 2 - 3
Auto Mail 

Checker Account 
Setup and 
Options
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2special
d from
l panel

Figure 2 - 4
Special Group Setup
Special Group
You may add the e-mail addresses of those you wish to assign to your 
group here. The Mail LED  will then blink fast when mail is receive
members of this group, if LED notification is enabled in the contro
(Figure 2 - 3).
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ata in the notebook computer. The
te other 2.5" IDE hard disk drives

ttom of your computer as seen be-
rting the hard disk are available in
e 6 - 4.

Hard Disk

1

- 10 Hard Disk Drive

Hard Disk Drive
The hard disk drive is used to store your d
hard disk can be taken out to accommoda
with a height of 9.5 mm.

The hard disk  is accessible from the bo
low. Further details on removing and inse
“Upgrading the Hard Disk Drive” on pag

Power Safety

Before attempting to
access any of the inter-
nal components of
your notebook please
ensure that the ma-
chine is not connected
to the AC power, and
that the machine is
turned off. Also ensure
that all peripheral ca-
bles, including phone
lines, are disconnected
from the computer.

Figure 2 - 5
Hard Disk Location

1
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2
e mod-
vice if

 label-
  on

Media Warning

Don’t try to remove a
floppy disk while the
system is accessing it.
This may cause the
system to “crash”.

Figure 2 - 6
Floppy Disk Drive

1

Fl

Floppy Disk Drive (FDD)
The computer is equipped with a fixed 1.44 MB, 3.5" floppy disk driv
ule. By default it is labeled “Drive A:”, and can be used as a boot de
properly set in the BIOS (refer to “Boot Menu” on page 5 - 14).

Inserting/Removing Floppy Disks
When using the floppy drive, always insert your floppy diskette with the
side facing up. To remove the inserted diskette, press the eject button
the top-right corner of the floppy drive.

Eject Button 1
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VD-ROM, or CD-RW, or Combi-

RW drive, depending on the model
 labeled “Drive D:”, and may be
 BIOS (“Boot Menu” on page 5 -

  and carefully place a CD/DVD
 (use just enough force for the disc
h the CD/DVD tray in until its lock
sy indicator  will light up while
/video CD, or DVD, is playing. If
n object such as a straightened pa-
o open the tray.

1

2

Button

3

- 12 CD/DVD Device

CD/DVD Device
There is a bay for either a CD-ROM, or D
nation CD-RW and DVD-ROM, or DVD-
you purchased. The CD Device is usually
used as a boot device if properly set in the
14).

Loading Discs
To insert a CD/DVD, press the open button
onto the disc tray with label-side facing up
to click onto the tray’s spindle). Gently pus
“clicks” and you are ready to start. The bu
data is being accessed, or while an audio
power is unexpectedly interrupted, insert a
per clip into the emergency eject hole  t

Sound Volume 
Adjustment

How high the sound
volume can be set de-
pends on the setting of
the volume control
within Windows. Click
the Speaker icon on
the taskbar to check
the setting. 

All peripherals must be
connected before you
turn on the system.

Figure 2 - 7
CD Device

3

Eject 
1 2
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2aged.
ur CD-

disc.

VD.

CD Emergency Eject

If you need to manually
eject a CD (e.g. due to
an unexpected power
interruption) you may
push the end of a
straightened paper clip
into the emergency
eject hole. However
please do NOT use a
sharpened pencil or
similar object that may
break and become
lodged in the hole.
Handling CDs or DVDs
Proper handling of your CDs/DVDs will prevent them from being dam
Please follow the advice below to make sure that the data stored on yo
ROMs/DVD-ROMs can be accessed.

Remember to:

• Hold the CD or DVD by the edges; do not touch the surface of the 
• Use a clean, soft, dry cloth to remove dust or fingerprints.
• Do not write on the surface with a pen.
• Do not attach paper or other materials to the surface of the disc.
• Do not store or place the CD or DVD in high-temperature areas.
• Do not use benzene, thinner, or other cleaners to clean the CD or D
• Do not bend the CD or DVD.
• Do not drop or subject the CD or DVD to shock.
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2 , not OS-dependent. You can select
th selection is permanent. This can-
ating system or you use the module
- 14 CD/DVD Device

DVD Regional Codes
DVD region detection is device dependent
your module’s region code 5 times. The fif
not be altered even if you change your oper
in another computer. 

Figure 2 - 8
DVD Regional Codes

(Windows XP)
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Table 2 - 3
DVD Regional Coding
Changing DVD Regional Codes
Go to the Control Panel in WindowsXP/Windows 2000 and double-clic
tem > Hardware (tab), click Device Manager, then click the + next to
CD-ROM drives. Double-click on the DVD-ROM device to bring 
Properties menu, and select the DVD Region (tab) to bring up the 
panel as seen in “DVD Regional Codes (Windows XP)” on page 2 - 
change the TV system to/from PAL or NTSC see “TV Format” on p
13. 

DVD Regional Coding

Region Geographical Location

1 USA, Canada

2 Western Europe, Japan, South Africa, Middle East & Egypt

3 South-East Asia, Taiwan, South Korea, The Philippines, Indonesia, 
Kong

4 South & Central America, Mexico, Australia, New Zealand

5 N Korea, Russia, Eastern Europe, India & Most of Africa

6 China
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 3.3V/5V slot for one type II PC

he PC Card (see “What to Install”

rds 
h it in until it locks into place.

 eject button  next to the slot.1

1

- 16 PC Card Slot

PC Card Slot
The computer is equipped with a PCMCIA
Card. Make sure you install the driver for t
on page 4 - 2).

Inserting and Removing PC Ca
• Align the PC Card with the slot and pus
• To remove a PC Card, simply press the

Figure 2 - 9
PC Card Slot
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Non-Default E-Mail 
and Browser 

Programs

It is possible to config-
ure both the e-mail and
browser Hot-Keys to
open non-default mail
and browser pro-
grams. Follow the pro-
cedure outlined on
page 2 - 18 but high-
light either the Brows-
er or Email in step 2.
Choose Custom to
browse to the program
of your choice as per
the remaining instruc-
tions. The Hot-Key will
now open this pro-
gram.

Table 2 - 4
Hot-Keys
Hot-Keys
The computer has two sets of Hot-Keys, three Hot-Key buttons on th
puter, and the function key combinations on the keyboard.

Hot-Key Buttons
These keys access the internet, e-mail or a user-defined application w
quick button press. To use the “user-defined Hot-Key”, you must ins
Hot-Key driver. Refer to “What to Install” on page 4 - 2 for driver insta
steps. 

Programming the Hot-Keys

After installing the Hot-Key driver you can configure or change the se

Hot-Key Function

Activate the default e-mail program

Activate the default Internet browser

Activate the user specified application e.g. Microsoft Word or E
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r Application 1 (the default Hot-
ion), you must follow the instruc-

 on the taskbar and the following 

to Application 1 and press Enter. 

creen.

ed application.exe (see the sidebar) 

ose Open.
program.
- 18 Hot-Keys

To configure and specify an application fo
Key setting is for the CD Player applicat
tions below.

1. Right click the Hot-Key driver icon 
menu will appear.

2. Select Setup from the menu and scroll 

3. An Open dialog box will appear on the s

4. Browse to the directory where the desir
program exists.

5. Double-Click on the program file or cho
6. The Hot-Key is now set to execute that 

Application.exe

You will need to locate
the actual application
executable (.exe) file,
not just the shortcut.
To find the application
right-click its shortcut
on the desktop and
click Properties. Click
the shortcut (tab) and
see where the execut-
able file is located by
clicking the Find Tar-
get (button).
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2

Fn key
s press
tc.) lo-

Other Keyboards

If your keyboard is
damaged or you just
want to make a
change, you can use
any standard PS/2 or
USB keyboard. The
system will detect and
enable it automatically.
However special func-
tions/hot keys unique
to the system’s regular
keyboard may not
work.

Table 2 - 5
Function Keys
Function Keys

Function Keys and Numeric Keypad
Function Keys
On the bottom-left of the keyboard is the Fn key or Function key. The 
allows you to change operational features instantly. To use the function
and hold the Fn key, then press the appropriate function key (F3 - F9 e
cated on your keyboard.

Keys Description

Fn Function Key
Fn + F3  Mute Toggle
Fn + F4 Sleep/Resume Toggle
Fn + F5 Decrease Audio Volume
Fn + F6 Increase Audio Volume
Fn + F7 Display Toggle
Fn + F8 Decrease LCD Brightness
Fn + F9 Increase LCD Brightness

Fn + F12 Multiple Wireless Modules Toggle
Fn + NumLk Number Lock Toggle
Fn + ScrLk Scroll Lock Toggle
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2

2 eypad for easy numeric data input.
low typeface.

ssing and holding the Fn key, then
 keyboard. You may check if Num-
e LED status indicators (see “LED
nabled, you do not need to hold the
meric keypad.

ing the Fn key, then press the Scr-

eric Keypad

Function Keys

NumLk & ScrLk
           Keys
- 20 Function Keys and Numeric Keypad

Numeric Keypad
The keyboard has an embedded numerical k
The numeric keys are highlighted by a yel

Activate the Number Lock feature by pre
press the NumLk key at the top right of the
ber Lock is enabled or not by looking at th
Indicators” on page 2 - 5). If NumLk is e
Fn key down to type a number from the nu

Activate Scroll Lock by pressing and hold
Lk key at the top right of the keyboard.

Special Characters

Some software appli-
cations allow the
number-keys to be
used with Alt to pro-
duce special charac-
ters. These special
characters can only be
produced by using the
numeric keypad. Reg-
ular number keys (in
the upper row of the
keyboard) will not
work. Make sure that
NumLk is on.

Figure 2 - 10
Keyboard

Num

Fn Key
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2
 on the
d pres-
ouse to
rts.

mouse.
Mouse

ll” on
chPad

indows
e-click
rinters

Mouse Driver

If you are using an ex-
ternal mouse your op-
erating system may be
able to auto-configure
your mouse during its
installation or only ena-
ble its basic functions.
Be sure to check the
device’s user docu-
mentation for details.

TouchPad Taskbar 
Icon 

You can add the
TouchPad icon to the
taskbar from the
Mouse control panel,
in the Others tab. Re-
start the computer to
see the icon appear in
the taskbar.
TouchPa

TouchPad and Buttons/Mouse
The TouchPad is a device for pointing (controlling input positioning)
computer’s display screen by sensing finger movement, and downwar
sure. It is an alternative to the mouse, however, you can also add a m
your computer either through the PS/2 interface, or one of the USB po

The TouchPad buttons function in much the same way as a two-button 
The central button may be configured to function as you require (see “
Properties” on page 2 - 22 for screen examples).

Configuring the TouchPad and Buttons
Once you have installed the TouchPad drivers (see “What to Insta
page 4 - 2) you can configure the functions by double-clicking the Tou
icon  in the taskbar, or by going to the Mouse control panel in W
(Start menu and point to Settings and click Control Panel, then doubl
the Mouse icon). In Windows XP the Mouse control panel is in the P
and Other Hardware Category.

Right-click the taskbar icon  and select Easy Launcher to
run programs from this menu. To add programs to the menu, see
“Easy Launcher” on page 2 - 22 for details.
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2

- 22 TouchPad and Buttons/Mouse

Easy Launcher

You can add programs
to the menu from the
Others tab in the
Mouse control panel.
Click on Settings for
Easy Launcher to get
the settings options.

Click the New button
and browse to any pro-
grams you wish to add
to the menu.

Restart the computer
and run Easy Launch-
er by right-clicking the
icon in the taskbar.

Click Close or Mini-
mize to quit the menu.

Figure 2 - 11
Mouse Properties
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entions
 printer

 of the

, toner/

puter.
 or ask 
Adding a Printer
The most commonly used peripheral is a printer. The following conv
will help you to add a printer, however it is always best to refer to the
manual for specific instructions and configuration options.

USB Printer
Most new printers have a USB interface connection. You may use any
USB ports on your computer to connect the printer.

Install Instructions:
1. Set up the printer according to its instructions (unpacking, paper tray

ink cartridge etc.). 
2. Turn ON the computer.
3. Turn ON the printer. 
4. Connect the printer’s USB cable to one of the USB ports on the com
5. Windows will identify the printer and either load one of its own drivers

you to supply one. Follow the on-screen instructions.
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2

2 er.

ctions (unpacking, paper tray, toner/

e parallel port at the rear of the 
- 16).

her load one of its own drivers or 
reen instructions.
- 24 Adding a Printer

Parallel Printer
This is still the most common type of print

Install Instructions:
1. Set up the printer according to its instru

ink cartridge etc.).
2. Attach the parallel cable to the printer.
3. Connect the printer’s parallel cable to th

computer (see “Rear View” on page 1 
4. Turn ON the printer.
5. Turn ON the computer.
6. Windows will identify the printer and eit

ask you to supply one. Follow the on-sc
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3

crosoft

Drivers

You are unable to use
most advanced con-
trols until the neces-
sary drivers and
utilities are properly in-
stalled. If your system
hasn’t been properly
configured (your serv-
ice representative may
have already done that
for you), refer to “What
to Install” on page 4 -
2 for installation in-
structions.
Chapter 3: Advanced Controls
Overview
This chapter covers:

• Advanced video controls
• Power and battery management features
• Configuring the Infrared settings for FIR

Note: All operating system pictures in this manual are from the Mi
Windows XP OS.
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3

ls
or the LCD, and switching display

k at the screen straight on, without
ss controls (Fn + F8/F9).

9

- 2 Advanced Video Controls

Advanced Video Contro
This section is about making adjustments f
devices.

Opening the LCD
As you open the lid, adjust it so you can loo
any glare. If necessary, adjust the brightne

Protecting the LCD

Do not allow any for-
eign objects (i.e. paper
or plastic) to get be-
tween the lid/LCD and
the work panel. They
could damage or
scratch the LCD and/or
accidentally activate
the close cover switch.

Figure 3 - 1
Brightness 

Controls Fn

F8 F



Advanced Controls

Video Driver Controls 3 - 3

3
tput to
dware,
terface
e LCD

anel in
ll” on

Screen Resolution/
Screen Area Note

You may set the reso-
lution to a higher set-
ting than the panel
supports, however this
will require you to pan
(scroll) around the
screen as the display
area will be larger than
what you can see on
the LCD.
Video Driver Controls
The video interface lets you change the screen resolution and color ou
whatever is most comfortable/efficient for you. This is a matter of har
video memory and the driver for your operating system. The driver in
shows the available options (see “LCD Options” on page  A - 2 for th
options).

You can switch display devices from the Display Properties control p
Windows as long as the video driver is installed (see “What to Insta
page 4 - 2).
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3

splay
for, the more information the LCD
’s resolution and color depth go to

ontrol Panel.

lick Settings (tab).
ider to the preferred setting for 
age 3-5).
 and scroll to the preferred setting 
on page 3-5).

 right-clicking the ATI icon in the
y Settings, then click the Settings
- 4 Video Driver Controls

Making Adjustments for the Di
The higher the resolution you set the LCD 
can display on screen. To change the LCD
the Display Properties control panel:

1. Click Start, point to Settings and click C
2. Double-click Display (icon).
3. In the Display Properties dialog box, c
4. In Screen area/resolution, move the sl

resolution (see  in Figure 3 - 3 on p
5. In Colors/Color quality, click the arrow

for color depth (see  in Figure 3 - 3 

You can also access Display Properties by
taskbar. Point to Settings and click Displa
(tab).

Figure 3 - 2
ATI Display 

Settings

1

2
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3

d (but-
 you to

Figure 3 - 3
Advanced Display 

Properties 
When the Display Properties control panel is open, click the Advance
ton)  to bring up the options tabs. Clicking through these tabs allows
make any video adjustments you require.

3

1 2

3
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3

further help on display options, TV
 taskbar and point to Help or Trou-
- 6 Video Driver Controls

Access the menus from ATI taskbar to get 
options etc. Right-click the ATI icon in the
bleshooting (Figure 3 - 4). 

Figure 3 - 4
ATI Help & 

Troubleshooting
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3
 to the

lowing

 (CRT)
the Fn

Vertical Refresh Rate

The vertical refresh rate
of your CRT is impor-
tant. If it is too low and/
or you’re using fluores-
cent lighting, the screen
will appear to flicker. To
reduce flickering on a
CRT, use faster refresh
rates (we recommend a
refresh rate of 72Hz or
more). But first check
your monitor’s docu-
mentation to make sure
it can support the rates
listed by the video driv-
er. The default refresh
rate for VGA monitors
(without drivers) is
60Hz.

Figure 3 - 5
Monitor Properties
Display Devices
Besides the built-in LCD, you can also use an external CRT connected
VGA port as your display device. You may also connect a TV. The fol
are the display options:

1. The built-in LCD.
2. A CRT (external monitor) connected to the VGA port.
3. A TV connected to the S-Video connector.

Attaching a Monitor (CRT)
If you prefer to use a monitor (CRT), connect it to the External Monitor
port on the rear panel (see “Rear View” on page 1 - 16). You can use 
+ F7 keys to toggle through the display options.
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d, then configured to your require-

ws XP Windows 2000

Not Available

isplay device.
tputting the same view (you can 
 resolutions and refresh rates).
RT or TV outputting a different 
 Windows 2000) - see - 
0.
- 8 Display Options

Display Options

Firstly the display devices must be enable
ments.

Display Mode Windo

Single

Multiple - Clone Mode 

Multiple - Extended 
Desktop Mode

Single - Either the LCD, CRT or TV as a d
Multiple (Clone) - The LCD, CRT or TV ou
apply different display modes with different
Multiple (Extended Desktop) -The LCD, C
view (In Windows XP only - not available in
“Extended Desktop Mode” on page 3 - 1

TV Support

You cannot set your
flat panel display and
TV to the same display
mode.

Table 3 - 1
Display Options
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3
. In the
) click
fferent
on 
ry ,
 Mode,

Primary & Clone 
Displays

The Primary display in
an Extended Desktop
environment will be as-
sociated with display
Icon 1 in the settings
tab.

The Clone display will
set the associated dis-
play to show a copy of
the Primary desktop.

The Clone display in
an Extended Desktop
environment will show
the portion of the desk-
top extended from the
Primary display.

Figure 3 - 6
Displays Tab
E

Enabling Other Displays
Attach a monitor to the External Monitor (CRT) port on the rear panel
Advanced ATI Mobility Radeon Properties (Figure 3 - 3 on page 3-5
on Display to get the other display options, including those for TV (di
OS’s will appear with different options). Click the enable/disable butt
for the display device you wish to use. Select ONE display as Prima
the remaining as the Clone  (the Clone may operate in either Clone
or Extended Desktop Mode).
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3
of the Primary display desktop on
ultiple displays with the same con-
through a projector for a presenta-
d independently as this allows you
etc., which require specific resolu-

he LCD and a CRT showing differ-
ts in Windows XP, but this mode is
tended Desktop creates a desktop

rge workspace.

rnal Monitor (CRT) port (or TV to the 

(see Figure 3 - 3 on page 3-5).
 6 on page 3-9).
r the display device you wish to use.
n the display device (give the 
refresh). 
 to save the changes. 
- 10 Enabling Other Displays

Clone Mode
Clone Mode simply shows an exact copy 
the other display(s). This mode will drive m
tent. Use this feature to display the screen 
tion. Each display device can be configure
to set the options for overhead projectors 
tions and refresh rates.

Extended Desktop Mode
The system supports Extended Desktop (t
ent views) in multiple display environmen
NOT supported in Windows 2000. An Ex
spanning multiple displays and acts as a la

To get this effect:

1. Attach your external monitor to the Exte
S-Video connector), and turn it on.

2. Go to the Advanced Display Settings 
3. Select the Displays tab (see Figure 3 -
4. Click the enable/disable button  fo
5. Click Apply and an image will appear o

monitor a few seconds for the image to 
6. Click Yes to accept the settings and OK
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u.

tch the 

eft, the 

ws 
ne 
 in the 

Figure 3 - 7
Extended Desktop 

Monitor 
Arrangement

Help

Further help is availa-
ble through the menus
accessed from the
taskbar (see Figure 3 -
4 on page 3-6).
En

7. Use the Display Properties window to select the second monitor by
clicking on the icon, or by selecting it from the “Display:” pop-up men

8. Click “Extend my Windows desktop onto this monitor.”
9. Click Apply (click Yes to keep the settings if prompted).
10. Use the Display Properties control panel to drag the monitors to ma

physical arrangement you wish to use.
11. In the example shown in Figure 3 - 7 the primary monitor  is on the l

other display is on the right.

12. With the Extended Desktop Mode enabled, drag any icons or windo
across to the other display desktop. It is therefore possible to have o
program visible in one of the monitors, and a different program visible
other monitor.

1

Click either the Display
pop-up menu, or click
the icon for the
appropriate display.
Then click the tick box
to extend the primary
display’s desktop to it.
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nd the other to 2 (Clone). The 
e as set to Primary.

e back to Clone mode, first uncheck 
sktop (via the settings tab in the 
ick Apply (see “Extended 

 page 3 - 11).
her Displays” on page 3 - 9 to 
n to enable displays if necessary).
- 12 Enabling Other Displays

13. One display will be set to 1 (Primary), a
displays may be switched as long as on

14. To switch from Extended Desktop mod
the tick box to disable the Extended De
Display Properties control panel) and cl
Desktop Monitor Arrangement” on

15. Repeat the procedure in “Enabling Ot
return to Clone mode (click the  butto

Figure 3 - 8
Displays Tab 

(Extended Desktop 
Mode)
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3
mputer
e com-
V dis-

ection
e 3-6).

TV Format

If you need to change
the format for TV
Broadcast, plug your
TV in to the S-Video
connector then go to
Display Properties >
Settings > Advanced
> Displays and click
TV (button).

Click the Format (tab)
and select a country
from the list.

Figure 3 - 9
TV Format
Enabling TV Display
To display desktop images on a TV display, connect the TV to your co
by using an S-Video cable from the TV to the connector at the rear of th
puter (see “Rear View” on page 1 - 16). You will need to enable the T
play from the Displays tab (Figure 3 - 6 on page 3-9).

Further help is available to help you troubleshoot your TV conn
through the menus accessed from the taskbar (see Figure 3 - 4 on pag
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tures
the battery, your notebook comput-
em. Power management conserves
ts of the computer (the monitor and

ower Interface
 with enhanced power saving tech-
) direct control over the power and
or example, it enables the OS to set
r settings and information from ap-
ows 2000 and Windows XP.
- 14 Power Management Features

Power Management Fea
To conserve power, especially when using 
er uses the ACPI power management syst
power by controlling individual componen
hard disk drive) or the whole system.

Advanced Configuration and P
The ACPI interface provides the computer
niques and gives the operating system (OS
thermal states of devices and processors. F
devices into low-power states based on use
plications. ACPI is fully supported in Wind

OS Note

Power management
functions will vary
slightly depending on
your operating system.
For more information it
is best to refer to the
user’s manual of your
operating system. 

(Note: All pictures
used on the following
pages are from the
Windows XP OS.)
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3
s sys-

 power

out the

Figure 3 - 10
Power Options
Control Panel
En

Enabling Power Options
Power Options are enabled through the control panel in your Window
tem (Power Options). With other operating systems you may have
management available, so check your documentation.

You may conserve power through individual components or through
whole system.
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omponents)

r to turn off after a specified time.

rned off if the hard disk drive has
 time. If the system reads or writes
ck on.
- 16 Enabling Power Options

Conserving Power (Individual C

Turn off Monitor
To conserve power, you can set the monito

Turn off Hard Disk
The computer's hard disk motor will be tu
not been accessed for a specified period of
data, the hard disk motor will be turned ba

Resuming Operation

The system can
resume from Monitor
or Hard Disk Standby
by pressing a key on
the keyboard.

Figure 3 - 11
Power Schemes
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3
 where
 levels
Hiber-
-18).

nd you

ast left
s) and

he sys-
 up the
En

Conserving Power (System)
With this function you can stop the notebook’s operation and restart
you left off. This system features Standby and Hibernate sleep mode
(Hibernate mode will need to be enabled by clicking the option in the 
nate tab in the Power Options control panel - Figure 3 - 12 on page 3

Hibernate Mode vs. Shutdown
Hibernate mode and Shutdown are the same in that the system is off a
need to press the power button to turn it on. Their main difference is:

When you come back from hibernation, you can return to where you l
off (what was on your desktop) without reopening the application(
file(s) you last used.

You can use either method depending on your needs. 

Standby Mode vs. Hibernate Mode
If you want to stay away from your work for just a while, you can put t
tem on standby instead of in hibernation. It takes a longer time to wake
system from Hibernate mode than from Standby mode.



Advanced Controls

3

3
ut takes the shortest time to return

 disk is turned off, and the CPU is
applications are retained in memo-
 for a certain length of time, which
enter Standby mode to save power. 

 your information on a part of the
gh it saves the most power it takes

. You can set your notebook to au-
e battery power is almost depleted.
om the Hibernate tab in the Power
esume from Hibernate mode by
- 18 Enabling Power Options

Standby
Standby saves the least amount of power, b
to full operation. During Standby the hard
made to idle at its slowest speed. All open 
ry. When you are not using your computer
you specify in the operating system, it will 

Hibernate
Hibernate uses no power and saves all of
HDD before it turns the system off. Althou
the longest time to return to full operation
tomatically enter Hibernate mode when th
You will need to enable Hibernate mode fr
Options control panel. The system will r
pressing the power button.

System Resume

The system can
resume from Standby
mode by:

• Pressing the 
power button

• Pressing the key 
combination Fn + 
F4

• An alarm resume 
that is enabled and 
expires

• An incoming call 
received on the 
modem

Figure 3 - 12
Enable Hibernation
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3
 or Hi-
ll flash
er sav-
d disk,

Sleep Button

You may also config-
ure the Sleep/Resume
key combination (Fn +
F4) from the menu il-
lustrated in Figure 3 -
13. In Windows this is
referred to as the
Sleep button.

Figure 3 - 13
Power Options

(Advanced - Power 
Buttons)

on
En

Configuring the Power Button
The power button may be set to send the computer in to either Standby
bernate mode (Figure 3 - 13). In Standby mode, the LED  wi
green, and in Hibernate mode the LED will be off. If you are in a pow
ing mode set to save power through individual components (e.g. har
monitor), the LED will remain green.

Power Button Sleep/Resume(Sleep)Butt
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t the best use out of your battery.

arge, a new battery before using it
tructions on how to do this).

dependent upon many factors, in-
peripheral devices attached. Power
g the battery life if configured ap-

oper maintenance. To optimize the
charge and recharge the battery at

he battery yourself. Please consult
d to remove the battery for any rea-
- 20 Battery Information

Battery Information
Please follow these simple guidelines to ge

New Battery
Always completely discharge, then fully ch
(see “Battery FAQ” on page 3 - 21 for ins

Battery Life
Your notebook computer’s battery life is 
cluding the programs you are running, and 
Options settings in the OS will help prolon
propriately.

Battery life may be shortened through impr
life and improve its performance, fully dis
least once every 30 days.

We recommend that you do not remove t
your service representative should you nee
son.

Caution

Danger of explosion if
battery is incorrectly
replaced.

Replace only with the
same or equivalent
type recommended by
the manufacturer. Dis-
card used battery ac-
cording to the
manufacturer’s in-
structions.
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s level
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Conserving Battery 
Power

To conserve battery
power:

Close modem or com-
munication applica-
tions when they are not
being used.

Remove any unused
PC Cards from the
computer (PC Cards
quickly use up battery
power even if the sys-
tem enters sleep
mode).

Disconnect any unnec-
essary external devic-
es.
Battery FAQ
How do I completely discharge the battery?
Use the computer with battery power until it shuts down due to a low b
Don’t turn off the computer by yourself even when you see a message 
dicates the battery is critically low, just let the computer use up all of t
tery power and shut down on its own (it is best to disable the Power O
functions in the Control Panel). As the battery nears the end of its li
and close any critical files.

How do I fully charge the battery?
When charging the battery, don’t stop until the LED charging indicato
turns from orange to green.

How do I maintain the battery?
Completely discharge and charge the battery at least once every 30 day
ter about 20 partial discharges.

Conserving Battery Power
The LCD display consumes a lot of power, so lowering the brightnes
will save power. Different applications and external devices consume 
power even when they are not being used (see the sidebar note for f
recommendations on battery conservation).
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 Settings for FIR
e infrared device in the BIOS (see
nu)” on page 5 - 11) to enable the

ared (FIR) communication follow

ontrol Panel.

ties (button).

ange the Value to “HP HSDL-

 manual of the device you wish to
- 22 Configuring the Infrared Settings for FIR

Configuring the Infrared
You will need to change the settings for th
“I/O Device Configuration (Advanced Me
FIR setting support.

To configure your computer for Fast Infr
these steps:

1. Click Start, point to Settings and click C
2. Double-click Wireless Link icon.
3. Click Hardware (tab), then click Proper
4. Select Advanced (tab).
5. Select “Infrared Transceiver A” and ch

2300/3600”.
6. Click OK > OK.

For further information, please refer to the
connect. 

Infrared 
Communication

The infrared transceiv-
er operates on a “Line
of Sight”.

Make sure nothing is
blocking the “Line of
Sight” between your
system’s transceiver
and the destination’s
transceiver.
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Assumption

t you will install all drivers and utilities
CD device and it is assigned to “Drive
 all file extensions can be seen [see
wse...) to D:” on page 4 - 3].
Chapter 4: Drivers & Utilities
Overview
This chapter deals with installing the drivers and
utilities essential to the operation or improvement
of some of the computer’s subsystems. The system
takes advantage of some newer hardware compo-
nents for which the latest versions of most available
operating systems haven’t built in drivers and utili-
ties. Thus, some of the system components won’t
be auto-configured with an appropriate driver or
utility during operating system installation. Instead,
you need to manually install some system-required
drivers and utilities. In this chapter, we group driver
and utility installation instructions by operating
system. The following operating systems are cov-
ered.

• Windows 2000 Professional
• Windows XP

We assume tha
from the built-in 
D:”. In addition,
“Navigate (Bro
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ss Module ON/OFF Switch

g the drivers make sure that the
le ON/OFF switch is turned OFF,
to install the drivers for the 802.11b
r Bluetooth modules. Before install-
 Wireless LAN or Bluetooth drivers
 ON. If you have both the 802.11b

nd Bluetooth modules, use the Fn +
ation to toggle the power to the mod-
reless LAN & Bluetooth Modules”
r more information.

ows 2000 Service Pack 3

 you install Windows 2000 Service
stalling all the drivers.

dows XP Service Pack 1

t you install Windows XP Service
stalling all the drivers (if your Win-
n includes Service Pack 1 you can
- 2 What to Install

What to Install
The Device Drivers & Utilities + User’s Manual
CD-ROM contains the drivers and utilities neces-
sary for the proper operation of the computer.
Table 4 - 1 on page 4-5 lists what you need to in-
stall manually according to your choice of the oper-
ating system. It is very important that the drivers
are installed in the order indicated in the table.

Optional Module Drivers
The procedures for installing drivers for the op-
tional Wireless Lan, PC Camera and Bluetooth
modules are provided in “Optional Modules” on
page 7 - 1. Make sure that the drivers are installed
in the order indicated in Table 4 - 1 on page 4-5. If
your purchase does not include any of the optional
modules, DO NOT Install the drivers for them.

Wirele

While installin
Wireless Modu
until you come 
Wireless LAN o
ing the 802.11b
turn the switch
Wireless LAN a
F12 key combin
ule(s). See “Wi
on page 7 - 2 fo

Wind

Make sure that
Pack 3 after in

Win

Make sure tha
Pack 1 after in
dows XP versio
skip this step).



Drivers & Utilities

What to Install 4 - 3

4

Driver Message
message telling you that the driver
g is not authorized (Digital Signa-
), just click Yes or Continue Any-
 the message and continue the
edure.

e this message in cases where the
released after the version of Win-
rrently using. All the drivers pro-
 already received certification for

flict Message
stallation if you encounter any “file
 message, please click the default
y Windows (this will be the high-
Authorized 
If you receive a 
you are installin
ture Not Found
way to ignore
installation proc

You will receiv
driver has been 
dows you are cu
vided will have
Windows.

Version Con
During driver in
version conflict”
option offered b
lighted option).

Navigate (Browse...) to D:

You will notice that many of the instructions for driver
installation require you to “Navigate (Browse...) to
D:”.

In this case “D:” is the drive specified for your CD de-
vice. Not all computers are setup the same way, and
some computers have the CD listed under a different
drive letter - e.g. if you have two hard drives (or hard
disk partitions) one may be designated as “Drive C:”
and the other as “Drive D:”. In this case the CD device
may be designated as “Drive E:” - Please make sure
you are actually navigating to the correct drive letter
for the CD device.

When you click the Browse (button) after clicking
Run in the Start menu you will see the “Look in:” di-
alog box at the top of the Browse window. Click the
scroll button to navigate to My Computer to display
the devices and drive letters.
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ot listed in the Add/Remove Pro-

menu), point to Settings and click 
el. Double-click System (icon) 
 Hardware (tab) > Device Man-
.
 the device you wish to update/
river for (you may need to click 

Update Driver button (check the 
nd follow the on screen prompts.
- 4 What to Install

Updating/Reinstalling Individual 
Drivers
If you wish to update/reinstall individual drivers it
may be necessary to uninstall the original driver.
To do this go to the Control Panel in the Windows
OS and double-click the Add/Remove Programs
item. If you see the individual driver listed (if not
see below), uninstall it, following the on screen
prompts (it may be necessary to restart the comput-
er). Go to the appropriate section of the manual to
complete the update/reinstall procedure for the
driver in question.

If the driver is n
grams item:

1. Click Start (
Control Pan
and then click
ager (button)

2. Double-click
reinstall the d
“+”).

3. Look for the 
Driver tab) a
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Windows XP

page 4 - 12

page 4 - 12

page 4 - 12

page 4 - 13

l Windows XP Service Pack 1, after 
lling all the drivers to get support for 
2.0.

page 4 - 13

See page 7 - 12

page 4 - 14

page 4 - 14

See page 7 - 4

See page 7 - 7

page 4 - 15
Table 4 - 1
Install Procedure

Feature Windows 2000 

Audio page 4 - 7

Modem page 4 - 7

Network (LAN) page 4 - 7

Video page 4 - 7

USB 2.0 page 4 - 8
Instal
insta
USB 

PC Card/PCMCIA page 4 - 8

PC Camera See page 7 - 11

Hot-Key page 4 - 9

TouchPad page 4 - 9

Wireless LAN See page 7 - 3

Bluetooth See page 7 - 5

Auto Mail page 4 - 10
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4 ows 2000 Service Pack 3 

 you install Windows 2000 Service
stalling all the drivers.

ss Module ON/OFF Switch

g the drivers make sure that the
le ON/OFF switch is turned OFF,
to install the drivers for the 802.11b
r Bluetooth modules. Before install-
 Wireless LAN or Bluetooth drivers
 ON. If you have both the 802.11b

nd Bluetooth modules, use the Fn +
ation to toggle the power to the mod-
reless LAN & Bluetooth Modules”
r more information. If the Found New
rd appears at any time (other than

in the driver install procedure), click
- 6 Windows 2000 Professional

Windows 2000 Professional
This section covers driver and utility installation in-
structions for Windows 2000 Professional.

New Hardware Found
If you see the message “New Hardware Found”
(Found New Hardware Wizard) during the
installation procedure (other than when outlined in
the driver install procedure), click Cancel to close
the window, and follow the installation procedure
as directed.

Wind

Make sure that
Pack 3 after in

Wirele

While installin
Wireless Modu
until you come 
Wireless LAN o
ing the 802.11b
turn the switch
Wireless LAN a
F12 key combin
ule(s). See “Wi
on page 7 - 2 fo
Hardware Wiza
when outlined 
Cancel.
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00)
menu) > Run...
owse... to 
an\Setup.exe and click OK.
lick Next.
 then restart the computer.
settings can now be configured.

000)
menu) > Run...
owse..) to 
ga\Setup.exe and click OK. 
lick Next > Yes > Express.
to restart the computer when 

ed Video Controls” on page 3 - 2 
 adjusting the video settings.
Wind

Audio (Win2000)
1. Click Start (menu) > Run...
2. Navigate (Browse...) to 

D:\Drivers\Audio\Setup.exe and click OK > 
Next.

3. Click Finish to restart your computer.
4. You can click the AC97 Audio Configuration 

icon  in the taskbar for configuration options.

Modem (Win2000)
1. Click Start (menu) > Run...
2. Navigate (Browse..) to 

D:\Drivers\MODEM\WIN2000\Setup.exe 
and click OK.

3. The driver will install and quit the installer 
menu automatically. The modem is ready for 
dial-up configuration.

LAN (Win20
1. Click Start (
2. Navigate (Br

D:\Drivers\l
3. To continue c
4. Click Finish,
5. The network 

Video (Win2
1. Click Start (
2. Navigate (Br

D:\Drivers\v
3. To continue c
4. Click Finish 

prompted.
5. See “Advanc

for details on

Modem Country Selection

Be sure to check if the modem country selection is ap-
propriate for you (Control Panel > Phone and Mo-
dem Options and select a Country).
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MCIA (Win2000)
menu), point to Settings and click 
el. Double-click System (icon) 
 Hardware (tab) > Device Man-
.
 Manager (tab), then click “+” 
CIA (if its sub-items are not 

 Generic CardBus Controller, 
Driver (tab).
 Driver (button).
grade Device Driver Wizard 
 Next.

ch for a suitable driver for my 
mended)” and click Next.

 Driver Files appears, select 
ify a location” and click Next.
owse...) to 
cmcia\Win2k.
 OK > Next.
and close the open windows.
restart your computer.
- 8 Windows 2000 Professional

USB 2.0 (Win2000)
1. Click Start (menu) > Run...
2. Navigate (Browse...) to 

D:\Drivers\Usb2.0\USB20.exe (or 
D:\Drivers\Usb2.0\win2000\USB20.exe) and 
click OK.

3. Click Yes > Accept.
4. Click Yes to restart the computer.

PC Card/PC
1. Click Start (

Control Pan
and then click
ager (button)

2. Click Device
next to PCM
shown).

3. Double-click
and click the 

4. Click Update
5. When the Up

appears, click
6. Select “Sear

device (recom
7. When Locate

ONLY “Spec
8. Navigate (Br

D:\Drivers\P
9. Click Open >
10.Click Finish 
11.Click Yes to 
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Win2000)
menu), point to Settings and click 
el. Double-click System (icon) 
 Hardware (tab) > Device Man-
.
t to Mice and other pointing 
 sub-items are not shown). 
 PS/2 Compatible Mouse and 
(tab). 
 Driver (button) and click Next.
tall Hardware Device Drivers 
ars, select “Display a list of the 
rs for this device so that I can 
cific driver)” and click Next.
isk (button).

owse...) to 
ouchpad\WIN2000.
 OK > Next > Next (click Yes if 

want to continue).
and close the open windows.
restart your computer.
 configure your TouchPad as 
onfiguring the TouchPad and 

page 2 - 21.
Wind

PC Camera (Win2000)
See install procedure in “PC Camera Driver In-
stallation (Win2000)” on page 7 - 11.

Hot-Key (Win2000)
1. Click Start (menu) > Run...
2. Navigate (Browse...) to 

D:\Drivers\Hotkey\Setup.exe and click OK.
3. Choose the language you prefer, and click OK.
4. Click Next.
5. Click Finish to restart your computer.
6. You may then configure your Hot-Key buttons 

as outlined in “Hot-Keys” on page 2 - 17.

TouchPad (
1. Click Start (

Control Pan
and then click
ager (button)

2. Click “+” nex
devices (if its

3. Double-click
click Driver 

4. Click Update
5. When the Ins

window appe
known drive
choose a spe

6. Click Have D
7. Navigate (Br

D:\Drivers\t
8. Click Open >

asked if you 
9. Click Finish 
10.Click Yes to 
11.You may then

outlined in “C
Buttons” on 
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in2000)
menu) > Run...
owse...) to 
utoMail\SETUP.EXE and click 

lick Next > Next.
 then restart your computer.
ram from the Start menu (point to 
Auto Mail Checker and click 
hecker). 
 the taskbar icon to access the 
s (see “Auto Mail Checker” on 

go to the Microsoft web site to
stall Service Pack 3 for Windows
- 10 Windows 2000 Professional

Wireless LAN (Win2000)
See install procedure in “Wireless LAN Driver In-
stallation (Win2000)” on page 7 - 3.

Bluetooth (Win2000)
See install procedure in “Bluetooth Driver Instal-
lation (Win2000)” on page 7 - 5.

Auto Mail (W
1. Click Start (
2. Navigate (Br

D:\Drivers\A
OK.

3. To continue c
4. Click Finish,
5. Run the prog

Programs > 
Auto Mail C

6. Double-click
settings menu
page 2 - 7).

You may then 
download and in
2000.
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dows XP Service Pack 1

t you install Windows XP Service
stalling all the drivers (if your Win-
n includes Service Pack 1 you can

ss Module ON/OFF Switch

g the drivers make sure that the
le ON/OFF switch is turned OFF,
to install the drivers for the 802.11b
r Bluetooth modules. Before install-
 Wireless LAN or Bluetooth drivers
 ON. If you have both the 802.11b

nd Bluetooth modules, use the Fn +
ation to toggle the power to the mod-
reless LAN & Bluetooth Modules”
r more information. If the Found New
rd appears at any time (other than
river install procedure), click Cancel.
Windows XP
This section covers driver and utility installation in-
structions for Windows XP.

New Hardware Found
If you see the message “New Hardware Found”
(Found New Hardware Wizard) for the Univer-
sal Serial Bus (USB) Controller during the instal-
lation procedure, click Cancel to close the window,
and follow the installation procedure as directed. At
the end of the installation procedure, install Service
Pack 1 for USB 2.0 support.

Driver Installation and Multi Language Options

Make sure you have not enabled any of the Multi lan-
guage options in the Regional and Language Op-
tions control panel before installing the drivers. Some
of these language options will interfere with the driver
installation process for the Audio driver. After you
have installed all the drivers you may then configure
the language options.

Win

Make sure tha
Pack 1 after in
dows XP versio
skip this step).

Wirele

While installin
Wireless Modu
until you come 
Wireless LAN o
ing the 802.11b
turn the switch
Wireless LAN a
F12 key combin
ule(s). See “Wi
on page 7 - 2 fo
Hardware Wiza
outlined in the d
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XP)
menu) > Run...
owse...) to 
ODEM\WINXP\Setup.exe and 

ill install and quit the installer 
tically. The modem is ready for 

guration.

)
menu) > Run...
owse...) to 
an\Setup.exe and click OK.
lick Next.
 then restart the computer.
settings can now be configured.

dem Country Selection

 the modem country selection in the
ontrol Panel > Phone and Modem

and select a Country).
- 12 Windows XP

Audio (WinXP)
1. Click Start (menu) > Run...
1. Click Start (menu) > Run...
2. Navigate (Browse...) to 

D:\Drivers\Audio\Setup.exe and click OK > 
Next.

3. Click Finish to restart your computer.
4. You can click the AC97 Audio Configuration 

icon  in the taskbar for configuration options.

Modem (Win
1. Click Start (
2. Navigate (Br

D:\Drivers\M
click OK.

3. The driver w
menu automa
dial-up confi

LAN (WinXP
1. Click Start (
2. Navigate (Br

D:\Drivers\l
3. To continue c
4. Click Finish,
5. The network 

Mo

You can change
control panel (C
Options (icon) 
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ck it to make the sub-menu appear 
wn to Properties and click on it 
.
 see the My Computer icon click 
, then point to (but don’t click just 

y Computer. Right-click it to 
-menu appear and scroll down to 
nd click on it (go to step 3).
rdware (tab), then click Device 
tton). 
t to PCMCIA Adapters (if its 
 not shown). 
 Generic Cardbus Controller 
ver (tab). 
 Driver (button).
rdware Update Wizard appears, 
l from a list or specific location 
 then click Next.

ch for the best driver in these 
nd select ONLY “Include this 
e search:”.

owse...) to 
CMCIA\WinXp and click OK > 

and close the open windows.
computer.
Video (WinXP)
1. Click Start (menu) > Run...
2. Navigate (Browse..) to 

D:\Drivers\vga\Setup.exe and click OK. 
3. To continue click Next > Yes > Express.
4. Click Finish to restart the computer when 

prompted.
5. See “Advanced Video Controls” on page 3 - 2 

for details on adjusting the video settings.

USB 2.0 (WinXP)

PC Card/PCMCIA (WinXP)
1. If you can see the My Computer icon on your 

desktop (if you cannot see the My Computer 
icon go to step 2) click on it once to select it, 

then right-cli
and scroll do
(go to step 3)

2. If you cannot
Start (menu)
highlight it) M
make the sub
Properties a

3. Click the Ha
Manager (bu

4. Click “+” nex
sub-items are

5. Double-click
and click Dri

6. Click Update
7. When the Ha

click “Instal
(Advanced)”

8. Select “Sear
locations.” a
location in th

9. Navigate (Br
D:\Drivers\P
Next.

10.Click Finish 
11.Restart your 

Install Windows XP Service Pack 1

Install Windows XP Service Pack 1 after installing
all the drivers to get support for USB 2.0.
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-menu appear and scroll down to 
nd click on it (go to step 3).
rdware (tab), then click Device 
tton).
t to Mice and other pointing 
 sub-items are not shown).
 PS/2 Compatible Mouse and 
(tab). 
 Driver (button).
rdware Update Wizard appears, 
l from a list or specific location 
 then click Next.
t search I will choose the driver 
en click Next.
isk (button).

owse...) to 
ouchpad\winxp and click Open > 
click Continue Anyway if asked 
 continue).
and close the open windows.
restart your computer.
 configure your TouchPad as 
onfiguring the TouchPad and 

page 2 - 21.
- 14 Windows XP

PC Camera (WinXP)
See install procedure in “PC Camera Driver In-
stallation (WinXP)” on page 7 - 12.

Hot-Key (WinXP)
1. Click Start (menu) > Run...
2. Navigate (Browse...) to 

D:\Drivers\Hotkey\Setup.exe and click OK.
3. Choose the language you prefer, and click OK.
4. Click Next.
5. Click Finish to restart your computer.
6. You may then configure your Hot-Key buttons 

as outlined in “Hot-Keys” on page 2 - 17.

TouchPad (WinXP)
1. If you can see the My Computer icon on your 

desktop (if you cannot see the My Computer 
icon go to step 2) click on it once to select it, 
then right-click it to make the sub-menu appear 
and scroll down to Properties and click on it 
(go to step 3).

2. If you cannot see the My Computer icon click 
Start (menu), then point to (but don’t click just 
highlight it) My Computer. Right-click it to 

make the sub
Properties a

3. Click the Ha
Manager (bu

4. Click “+” nex
devices (if its

5. Double-click
click Driver 

6. Click Update
7. When the Ha

click “Instal
(Advanced)”

8. Select “Don’
to install.” th

9. Click Have D
10.Navigate (Br

D:\Drivers\t
OK > Next (
if you want to

11.Click Finish 
12.Click Yes to 
13.You may then

outlined in “C
Buttons” on 
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inXP)
menu) > Run...
owse...) to 
utoMail\SETUP.EXE and click 

lick Next > Next.
 then restart your computer.
ram from the Start menu (point to 
ll Programs > Auto Mail 
 click Auto Mail Checker).
 the taskbar icon to access the 
s (see “Auto Mail Checker” on 

go to the Microsoft web site to
stall Service Pack 1 for Windows
Wireless LAN (WinXP)
See install procedure in “Wireless LAN Driver In-
stallation (WinXP)” on page 7 - 4.

Bluetooth (WinXP)
See install procedure in “Bluetooth Driver Instal-
lation (WinXP)” on page 7 - 7.

Auto Mail (W
1. Click Start (
2. Navigate (Br

D:\Drivers\A
OK.

3. To continue c
4. Click Finish,
5. Run the prog

Programs/A
Checker and

6. Double-click
settings menu
page 2 - 7).

You may now 
download and in
XP.
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Overview 5 - 1

5

are: 

hanges
er first
r, keep
mation

f what
anging
ts, con-

BIOS Settings 
Warning

Incorrect settings can
cause your system to
malfunction. To correct
mistakes, return to
Setup and restore the
Setup Defaults with
<F9>.
Chapter 5: BIOS Utilities
Overview
This chapter gives a brief introduction to the computer’s built-in softw

Diagnostics: The POST (Power-On Self Test)

Configuration: The Setup utility 
If your computer has never been set up, or you are making important c
to the system (e.g. hard disk setup), then you should review this chapt
and note the original settings found in Setup. Even if you are a beginne
a record of the settings you find and any changes you make. This infor
could be useful if your system ever needs servicing.

There is one general rule: Don’t make any changes unless you are sure o
you are doing. Many of the settings are required by the system, and ch
them could cause it to become unstable or worse. If you have any doub
sult your service representative. 
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5

 adjust any of the BIOS settings, as
. However the following is a quick
you may need to change at some

Purpose

r of the devices on which the com-
r an operating system (OS) as it 
- 2 Important BIOS Settings

Important BIOS Settings
Generally speaking you should not have to
they will already be set for your computer
reference to the most important settings 
point.

Option Page #

Boot Order 5 - 14
Specifies the orde
puter searches fo
starts up.

Table 5 - 1
Important BIOS 

Settings
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er-On Self Test (POST) 5 - 3

5

to con-

wrong.
splay a

m will
ithout

POST Screen

1.BIOS information
2.CPU type 
3.Memory status
4.HDD identification

notice 
5.Enter Setup prompt

appears only during
POST

Note: The POST
screen as pictured is
for guideline purposes
only. The POST
screen on your compu-
ter may appear slightly
different.

Figure 5 - 1
POST Screen
The Pow

The Power-On Self Test (POST)
Each time you turn on the computer, the system takes a few seconds 
duct a POST, including a quick test of the on-board RAM (memory).

As the POST proceeds, the computer will tell you if there is anything 
If there is a problem that prevents the system from booting, it will di
system summary and prompt you to run Setup. 

If there are no problems, the Setup prompt will disappear and the syste
load the operating system. Once that starts, you can’t get into Setup w
rebooting.

Phoenix Bios 4.0 Release 6.0
Copyright 1985-2002 Phoenix Technologies Ltd.
All Rights Reserved
BIOS Revision: 1.00
KBC/EC Revision: 1.00.P1

CPU = Intel(R) Pentium(R) 4 CPU 3.06GHz
639K System RAM Passed
509M Extended RAM Passed
512K Cache SRAM Passed
64M Video RAM Passed
System BIOS shadowed
Fixed Disk 0: IC25N030ATCS04-0
ATAPI CD-ROM: DW-224E
Mouse Intialized

Press <F2> to enter SETUP

1

2
3

4

5



BIOS Utilities

5

5

here are two categories, “fatal” and

dicate there is something seriously
er to your service representative or
le.

You will get a message identifying
) followed by the prompt:

inue. It may work, without the cor-

 to correct the problem. If you still
setting, or if the “cure” seems even
- 4 The Power-On Self Test (POST)

Failing the POST
Errors can be detected during the POST. T
“non-fatal”.

Fatal Errors
These stop the boot process and usually in
wrong with your system. Take the comput
authorized service center as soon as possib

Non-Fatal Errors
This kind of error still allows you to boot. 
the problem (make a note of this message!

• Press <F1> to resume
• <F2> to enter Setup 

Press F1 to see if the boot process can cont
rect configuration. 

Press F2 to run the Setup program and try
get an error message after you change the 
worse, call for help.
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d man-

T. The
present
Error”,

mbina-
ill ap-
The Setup Program
The Phoenix Setup program tells the system how to configure itself an
age basic features and subsystems (e.g. port configuration).

Entering Setup
To enter Setup, turn on the computer and press F2 during the POS
prompt (“Press F2 to Enter Setup”) seen in Figure 5 - 1 is usually 
for a few seconds after you turn on the system. If you get a “Keyboard 
(usually because you pressed F2 too quickly) just press F2 again.

If the computer is already on, reboot using the Ctrl + Alt + Delete co
tion and then hold down F2 when prompted. The Setup main menu w
pear.
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vice on portions of the Setup.

ith five (5) menu headings. When
. Scroll through the features listed

 are in the box along the bottom of
ss F1 to call up a “General Help”
 or down the page.

e of each screen explains the high-
t its options.

 Enter to go to a sub-menu on that
 has a similar layout, but the Enter
- 6 The Setup Program

Setup Screens
The following pages contain additional ad

Along the top of the screen is a menu bar w
you select a heading, a new screen appears
on each screen to make changes to Setup.

Instructions on how to navigate each screen
the screen. If these tools are confusing, pre
screen, then use the arrow keys to scroll up

The “Item Specific Help” on the right sid
lighted item and has useful messages abou

If you see an arrow  next to an item, press
subject. The sub-menu screen that appears
key may execute a command.

Setup Menus

The Setup menus
shown in this section
are for reference only.
Your computer’s men-
us will indicate the con-
figuration appropriate
for your model and op-
tions.
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pm). If
ou will
s to re-

Figure 5 - 2
Main Menu

ults
xit

elp

or
ld.
Main Menu

System Time & Date (Main Menu)
The hour setting uses the 24-hour system (i.e., ØØ = midnight; 13 = 1 
you can change the date and time settings in your operating system, y
also change these settings. Some applications may also alter data file
flect these changes.

PhoenixBIOS Setup Utility

Main Advanced Security Boot Exit

F1 Help �� Select Item -/+ Change Values F9 Setup Defa
Esc Exit �� Select Menu Enter Select �Sub-Menu F10 Save and E

Item Specific H

<Tab>, <Shift Tab>,
<Enter> selects fie

System Time: [22:11:05]
System Date: [03/30/2003]

Legacy Diskette A: [1.44 MB 3½"]

�Primary Master [TOSHIBA MK2018GAP-(PM)]
�Secondary Master [TOSHIBA CD-R/RW SR-C8102-(]

System Memory: 640 KB
Extended Memory: 521216 KB

Main

13
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 to show the configuration of the
ay. These items are configured au-

o show the configuration of the CD
tically for you.
- 8 Main Menu

Primary Master (Main Menu)
Pressing Enter under opens the sub-menu
HDD that fits into the computer’s HDD b
tomatically for you.

Secondary Master (Main Menu)
Pressing Enter under opens the sub-menu t
device. These items are configured automa

Switching Hard Disks

Every time you install a
different hard disk in
the computer, it will be
(configured automati-
cally.



BIOS Utilities

Advanced Menu 5 - 9

5

indows

Figure 5 - 3
Advanced Menu

ults
xit

elp

ng

ch

r.
Advanced Menu

Installed O/S: (Advanced Menu)
This item tells the computer what operating system you’re using: W
2000, Windows XP use the same default setting Win2000/XP.

PhoenixBIOS Setup Utility

Main Advanced Security Boot Exit

F1 Help �� Select Item -/+ Change Values F9 Setup Defa
Esc Exit �� Select Menu Enter Select �Sub-Menu F10 Save and E

Item Specific H

Select the operati
system installed
on your system whi
you will use most
commonly.

Note: An incorrect
setting can cause
some operating
systems to display
unexpected behavio

Setup Warning
Setting itmes on this menu to incorrect
values may cause your system to malfunction.

Installed O/S: [Win2000/XP]

Intel On-Screen Branding Logo: [Disabled]

CPU Hyper-Threading [Disabled]

�Advanced Chipset Control
�I/O Device Configuration

USB Host Controller: [Disabled]

Reset Configuration Data: [No]

Advanced

Win2000/XP
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d Menu)
logo display on the screen.

)
led) Hyper-Threading if your com-
ith Hyper-Threading Technology,

ading will increase performance of
e and software you use. If you do
ding Technology, this menu op-
is option in Windows 2000. Once
 NOT disable the option.

enu>Advanced Chipset Control)
 CPU type.

vanced Chipset Control)
M reserved for use by the comput-
eeds. The RAM is available for use
 video system. The recommended
ting. This setting should not be set
- 10 Advanced Menu

Intel On-Screen Branding Logo Advance
Set this item to enable or disable the Intel 

CPU Hyper-Threading (Advanced Menu
You can enable (the default setting is disab
puter has an Intel Pentium® 4 Processor w
running the Windows XP OS. Hyper-Thre
your computer depending on the hardwar
not have a Processor with Hyper-Threa
tion will not appear. DO NOT enable th
you have enabled Hyper-Threading, DO

Chipset Information Menu (Advanced M
This item will display information on your

Graphics Aperture (Advanced Menu>Ad
The AGP aperture is an area of system RA
er’s video system for storing textures if it n
by the system as normal if not used by the
setting is 64MB, and this is the default set
lower than 32MB.

Hyper-Threading

To use Hyper-Threading you
must have a computer with a
Pentium 4 Processor with
Hyper-Threading Technol-
ogy, running the Windows
XP OS. The menu option will
not appear if your CPU does
not support Hyper-Threading.

If you are updating your
BIOS from a previous version
which did not have the Hyper-
Threading option, you must
reinstall Windows XP after
you have updated your
BIOS.

If you are changing your pro-
cessor from a cpu which sup-
ports Hyper-Threading, to
one which does not, you will
need to reinstall your OS.
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 Menu

 so.

port A
. These
evices
ion for

u have
 such a
Embedded Modem Device/Audio Device/1394 Device (Advanced
>Advanced Chipset Control)
These items allow you to disable these devices, should you need to do

I/O Device Configuration (Advanced Menu)
The sub-menus under this item include options to configure the Serial 
(Serial Mouse), Serial port B (Infrared) and Parallel (Printer) port
can be left to the default settings, however you may wish to use certain d
that require settings to be adjusted accordingly. Check the documentat
any such devices to see what settings are required.

USB Host Controller (Advanced Menu)
This item allows you to enable or disable support for USB hardware.

Reset Configuration Data (Advanced Menu)
This item is set to No as default. You can change the setting to Yes if yo
installed a new add-on which has reconfigured the system, resulting in
serious system conflict that the operating system is unable to boot.
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ess to the Setup utility itself, and
after you turn it on. These settings
sswords which will be set in your

tility

oot Exit

ange Values F9 Setup Defaults
lect �Sub-Menu F10 Save and Exit

Item Specific Help

Supervisor Password
controls access to the
setup utility.
- 12 Security Menu

Security Menu

Security Menu
The changes you make here affect the acc
also access to your machine as it boots up 
do not affect your machine or network pa
software OS.

Figure 5 - 4
Security Menu

PhoenixBIOS Setup U

Main Advanced Security B

F1 Help �� Select Item -/+ Ch
Esc Exit �� Select Menu Enter Se

Security

Supervisor Password Is: Clear

Set Supervisor Password [EEnter]

Fixed disk boot sector: [Normal]

Password on boot: [Disabled]
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s to the

forma-
n to it.
 substi-
e. This

a pass-
ho en-

ebar).

Password Warning

If you choose to set a
boot password, NEV-
ER forget your pass-
word.

The consequences of
this could be serious. If
you cannot remember
your boot password
you must contact your
vendor and you may
lose all of the informa-
tion on your hard disk.
Set Supervisor Password: (Security Menu)
Set a password for access to the Setup utility (this will not affect acces
computer OS, only the Setup utility).

Fixed disk boot sector: (Security Menu)
Choose Write Protect to protect the area of the hard disk containing in
tion on how to start up the computer from having information writte
This helps prevent viruses from affecting this area, however, it is not a
tute for proper virus protection supplied by updated anti-virus softwar
is merely an extra safeguard (see “Viruses” on page 8 - 4).

Password on boot: (Security Menu)
After setting the supervisor password, you can choose Enabled to set 
word (the supervisor password) for booting the computer. Only users w
ter a correct password can boot the system (see “Warning” in the sid
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 for an operating system (e.g. Win-
enu, and in this order. If it cannot

 will try to load it from the next de-
u.

ility

oot Exit

ange Values F9 Setup Defaults
lect �Sub-Menu F10 Save and Exit

Item Specific Help

Keys used to view or
configure devices:
<Enter> expands or
collapses devices with
a + or -
<Ctrl+Enter> expands
all
<Shift+1> enables or
disables a device.
<+> and <-> moves the
device up or down.
<n> May move removable
device between the Hard
Disk or Removable Disk
<d> Remove a device
that is not installed.

ot
- 14 Boot Menu

Boot Menu

Boot Menu
When you turn the computer on it will look
dows 2000) from the devices listed in this m
find the operating system on that device, it
vice in the order specified in the Boot Men

Figure 5 - 5
Boot Menu

PhoenixBIOS Setup Ut

Main Advanced Security B

F1 Help �� Select Item -/+ Ch
Esc Exit �� Select Menu Enter Se

Removable Devices
CD-ROM Drive
Hard Drive
Network Boot

Bo
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t order.

re may
-ROM.

16.
Boot devices usually are hard drives, floppy drives, CD-ROMs and
(Local Area Networks).

When you specify a device as a boot device on the Boot Menu, it requ
availability of an operating system on that device. Most home com
come with an operating system already installed on “Drive C:”.

If you wish to boot from a CD-ROM you will need to add it to the boo
As a general rule the order below is recommended:

1. Removable Devices (usually floppy disks)
2. CD-ROM Drive
3. Hard Drive
4. Network Boot

In everyday use you will usually boot from the hard drive, however the
be occasions when it is advantageous to boot from a floppy disk or CD

To boot from the network see “Enabling Network Boot” on page 5 - 
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Protocol
HDD, CD or LAN (network). To
the first item in the boot order. Fol-
nfigure the network boot protocol.

Boot Agent
.13

h

nds

devices

<F4>
ion Save/Quit
- 16 Boot Menu

Configuring the Network Boot 
The system supports booting from FDD, 
boot from a network, set Network Boot as 
low the full instructions in the sidebar to co

Enabling Network 
Boot

Go to the Boot Menu.

Set the Network Boot
option as the first prior-
ity in the list.

Save the changes and
exit.

At startup, press and
hold the Shift and F10
keys.

Configure the network
protocol.

Save the settings to
automatically boot
from the network.

Realtek RTL8139(X/8130/810X
Configuration Menu v2

Network Boot Protocol PXE
Boot Order Int 19
Show Config Message Enable
Show Message Time 3 Seco

PXE

Always boot network first, then local

<Esc> <Space> <Enter>
Quit Change Value Next Opt

Figure 5 - 6
Boot Agent Menu
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ore the
d erase

Figure 5 - 7
Exit Menu

lts
it

lp
Exit Menu

Exit Menu
Choosing to Discard Changes, or Exit Discarding Changes, will w
any changes you have made to the Setup. You can also choose to rest
original Setup defaults that will return the Setup to its original state, an
any previous changes you have made in a previous session.

PhoenixBIOS Setup Utility

Main Advanced Security Boot Exit

F1 Help �� Select Item -/+ Change Values F9 Setup Defau
Esc Exit �� Select Menu Enter Select �Sub-Menu F10 Save and Ex

Item Specific He

Exit System Setup and
save your changes to
CMOS.

Exit Saving Changes
Exit Discarding Changes
Load Setup Defaults
Discard Changes
Save Changes

Exit
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Warranty Warning

Please check with your
service representative
before undertaking any
upgrade procedures to
find out if this will VOID
your warranty.
Chapter 6: Upgrading The Com
Overview
This chapter contains information on upgrading the computer. Foll
steps outlined to make the desired upgrades. If you have any trouble o
lems you can contact your service representative for further help. Befo
begin you will need:

• A small crosshead or Phillips screwdriver
• A small regular slotted screwdriver
• An antistatic wrist strap

Before working with the internal components you will need to wear a
static wrist strap to ground yourself because static electricity may dam
components.

The chapter includes:

• Replacing the Battery
• Replacing the HDD
• Upgrading the System Memory
• Replacing the CD Device
Please make sure that you review each procedure before you perfo
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tem’s case, adding and sometimes

ades if:

 a service contract
ment 

r service representative to purchase
- 2 Overview

When Not to Upgrade
These procedures involve opening the sys
replacing parts.

You should not perform any of these upgr

• Your system is still under warranty or
• You don’t have all the necessary equip
• You’re not in the correct environment
• You doubt your abilities

Under any of these conditions, contact you
or replace the component(s).

Power Safety 
Warning

Before you undertake
any upgrade proce-
dures, make sure that
you have turned off the
power, and discon-
nected all peripherals
and cables (including
telephone lines). It is
advisable to also re-
move your battery in
order to prevent acci-
dentally turning the
machine on.
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ver.
int .

Warranty Warning

Please check with your
service representative
before undertaking any
upgrade procedures to
find out if this will VOID
your warranty.3

Figure 6 - 1
Battery Removal
Removing the Battery
If you are confident in undertaking upgrade procedures yourself, for
reasons it is best to remove the battery. Under normal circumstances w
ommend that you do not remove the battery.
Battery Removal Process
1. Turn the computer off, and turn it over.
2. Remove screws  &  from the battery cover, and remove the co
3. Carefully (use a small screwdriver) disconnect the battery cable at po
4. Lift the battery out of the computer’s battery bay. 
5. Connect the battery cable before reinserting the battery.

1 2

1 2

3
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k Drive
mmodate other 2.5" IDE hard disk

rage Devices” on page  A - 3). Fol-
structions, and install all necessary
o Install” on page 4 - 2, when set-

disk cover, and remove the cover.
 by carefully, but firmly, gripping 

ter’s hard disk bay.

5

5

- 4 Upgrading the Hard Disk Drive

Upgrading the Hard Dis
The hard disk drive can be taken out to acco
drives with a height of 9.5mm (h) (see “Sto
low your operating system’s installation in
drivers and utilities as outlined in “What t
ting up a new hard disk. 
Hard Disk Upgrade Process
1. Turn off the computer, and turn it over.
2. Remove screws  -  from the hard 
3. Disconnect the hard disk cable at point 

the plastic loop and easing it upwards.
4. Lift the HDD assembly out of the compu

HDD System 
Warning

New HDD’s are blank.
Before you begin make
sure:
You have backed up any
data you want to keep
from your old HDD.
You have all the CD-
ROMs and FDDs re-
quired to install your oper-
ating system and
programs.
If you have access to the
internet, download the lat-
est application and hard-
ware driver updates for
the operating system you
plan to install. Copy these
to a removable medium.

Figure 6 - 2
HDD Assembly 

Removal

1 4

1 2

34
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 disk 
ts to 

tion of 
HDD Cable

The hard disk cable
connects to the hard
disk in one way only.
The letters HD on the
cable should be on the
side which connects to
the hard disk (not the
side which connects to
the computer’s main-
board).

Figure 6 - 3
HDD Case 
Screws & 

Connector Cable
Upgrad

5. Carefully disconnect the hard disk cable  from the rear of the hard
assembly, and pay careful attention to which end of the cable connec
the hard disk (see sidebar). 

6. Remove screws  -  from the hard disk assembly.
7. Take the HDD out of the case, and pay careful attention to the orienta

the disk in the case.
8. Insert the new HDD into the case and replace screws  - .
9. Reconnect the HDD connector cable (see sidebar).
10. Reverse the removal procedure to install the new HDD assembly.

1

2 5

2 5

1

2

3

4

5



Upgrading The Computer

6

6

emory (RAM)
 200 pin Small Outline Dual In-line
orting DDR SDRAM SODIMM

024MB. The SO-DIMMs support-
e, and the total memory size is au-
once you turn on your computer. 
- 6 Upgrading the System Memory (RAM)

Upgrading the System M
The computer has two memory sockets for
(SO-DIMM) type memory modules supp
(2.5V) - DDR 200/ DDR 266/ DDR 333.

The main memory can be expanded up to 1
ed are 128MB, 256MB, and 512MB in siz
tomatically detected by the POST routine 
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 to the 
mputer.
ded or Figure 6 - 4

Memory Socket Cover 
Removal
Upgrading the

Memory Upgrade Process
1. Turn the computer off, and turn it over.
2. Remove screws  -  from the memory socket cover.
3. Carefully lift up the memory socket cover (a fan cable is still attached

mainboard and there is no need to disconnect it) and set it on the co
4. Remove any currently installed module(s), if it/they need to be upgra

replaced.

1 6

1

2

54

3
6
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&  in Figure 6 - 5) on the sides 
of the computer.

 remove it.
ule if necessary.
a 30° angle and fit the connectors 

2

1

- 8 Upgrading the System Memory (RAM)

5. Gently pull the two release latches (  
of the memory socket toward the sides 

6. The module  will pop-up, and you can
7. Repeat the process for the second mod
8. Insert a new module holding it at about 

firmly into the memory slot.

1

1

2
3

Contact Warning

Be careful not to touch
the metal pins on the
module’s connecting
edge. Even the clean-
est hands have oils
which can attract parti-
cles, and degrade the
module’s perfor-
mance.

Figure 6 - 5
Removing/

Installing a RAM 
Module 3
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Figure 6 - 6
Memory Sockets One 

& Two
Upgrading the

9. The module’s pin alignment will allow it to only fit one way. Make sure
module is seated as far into the slot as it will go. DO NOT FORCE th
module; it should fit without much pressure.

10. Press the module in and down towards the mainboard until the slot le
click into place to secure the module.

11. Replace the memory socket cover (be careful with the fan cable) and
screws (see Figure 6 - 4).

12. Restart the computer.
13. The BIOS will register the new memory configuration as it starts up.
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e
graded or changed.

ry socket cover.
r (a fan cable is still attached to the 
nnect it) and set it on the computer.
- 10 Upgrading the CD Device

Upgrading the CD Devic
The easy changeable CD device may be up

CD Device Upgrade Process
1. Turn the computer off, and turn it over.
2. Remove screws  -  from the memo
3. Carefully lift up the memory socket cove

mainboard and there is no need to disco
Figure 6 - 7

Memory Socket Cover 
Removal

1 6

1

2

54

3
6
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e.

Figure 6 - 8
CD Device Removal
Upg

4. Use a screwdriver to carefully push the CD device assembly out of th
computer at point .

5. Insert the new device and carefully slide it into the computer (the devic
fits one way). DO NOT FORCE IT; the screw holes should line up.

6. Replace the memory socket cover (be careful with the fan cable) and
screws (see Figure 6 - 4).

7. Restart the computer to allow it to automatically detect the new devic

1

1
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r
placing the existing processor with
your customer service representa-
s yourself, since if it is done incor-
ainboard.
- 12 Upgrading the Processor

Upgrading the Processo
If you want to upgrade your computer by re
a faster/new one you will need to contact 
tive. We recommend that you do not do thi
rectly you may damage the processor or m

Warranty

The CPU is not a user
serviceable part.
Opening this compart-
ment, or accessing the
CPU in any way, may
violate your warranty.

Unauthorized tamper-
ing with the HDD may
also violate your war-
ranty.
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Chapter 7: Optional Modules
Overview
This chapter contains the information on the various optional m
which may come with your computer, depending on the configuratio
chased. If you are unsure please contact your service representative

The chapter includes information on the following:

• The Wireless LAN & Bluetooth Modules
• The PC Camera

 Wireless Module ON/OFF Switch

While installing the drivers make sure that the Wireless Module ON/OFF swit
turned OFF, until you come to install the drivers for the 802.11b Wireless LA
Bluetooth modules. Before installing the 802.11b Wireless LAN or Bluetooth dr
turn the switch ON. If you have both the 802.11b Wireless LAN and Bluetooth m
ules, use the Fn + F12 key combination to toggle the power to the module(s). I
Found New Hardware Wizard appears at any time (other than when outlined in
driver install procedure), click Cancel.
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th Modules
.11b Wireless LAN module and/or
he supplied device driver(s) for it/
nly install the drivers for the op-
 will need to turn the module(s) on
nt of the computer.

 Bluetooth modules in your com-
 + F12 to toggle the power to the

will be indicated by the Mail LED
o Mail program, and mail is incom-
ill be shown (see “LED Power &
).

ng the ON/OFF switch  on will
 the Fn + F12 key combination to
s (see “LED Power & Communi-
wer status).

 auto-detected, and you do not need
- 2 Wireless LAN & Bluetooth Modules

Wireless LAN & Bluetoo
If your purchase includes the optional 802
Bluetooth module, make sure you install t
them as indicated in the following pages (o
tional modules you have purchased). You
by using the ON/OFF switch  at the fro

If you have both the Wireless LAN and
puter, you can use the key combination Fn
modules. The power status of the module 
indicator . If you have installed the Aut
ing, then the mail notification warning w
Communication Indicators” on page 2 - 6

If you have both wireless modules, turni
turn on one of the Wireless modules. Use
toggle power to the other, or both, module
cation Indicators” on page 2 - 6 for the po

If you have one wireless module it will be
to use the Fn + F12 key combination.

Communication 
Conflict

Do not try to use the
802.11b Wireless LAN
module and the Blue-
tooth module at the
same time, as this may
cause a communica-
tion conflict.

Wireless Device 
Operation Aboard 

Aircraft

The use of any porta-
ble electronic trans-
mission devices
aboard aircraft is usu-
ally prohibited. Make
sure the modules are
OFF if you are using
the computer aboard
aircraft.
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Network Protocols

During the install proc-
ess you may be asked
to install some network
protocols. To do this
go to the Network and
Dial-up Connections
control panel, and dou-
ble-click Local Area
Connection. Click In-
stall (button) and click
on Protocol (or any
Services or Clients
required) and Add
(button) to select the
protocols you require.
You will need to restart
the computer after in-
stalling some Proto-
cols/Services/
Clients.
Wireless LA

Wireless LAN Driver Installation (Win2000)
1. Turn the Wireless Module ON/OFF switch ON.
2. If you have two wireless modules, you may need to use the key co

tion Fn + F12 to enable the Wireless LAN module (the Mail LED
cator  will be green - see “LED Power & Communication 
Indicators” on page 2 - 6). If you only have the Wireless LAN m
go straight to step 3.

3. If the Found New Hardware Wizard appears, click Cancel.
4. Insert the Wireless LAN CD-ROM into the CD drive.
5. The program will run automatically.
6. Click Next > Next > Yes > Next > Next.
7. Click Yes if you wish to add a shortcut to the WLAN utility on the

top.
8. Follow the instructions to install the Adobe Acrobat Reader (if y

not already have Adobe Acrobat Reader installed) and click Yes if
if you want to continue.

9. Click OK > Finish then restart the computer.

The Wireless LAN User Manual is in Adobe .pdf format (Start me
point to Programs > IEEE 802.11b WLAN Utility (USB) > User Ma
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itch ON.

 may need to use the key combina-
AN module (the Mail LED indi-
wer & Communication 
 have the Wireless LAN module 

pears, click Cancel.
o the CD drive.

xt.
t to the WLAN utility on the desk-

dobe Acrobat Reader (if you do 
er installed) and click Continue 
ue.

obe .pdf format (Start menu and
E 802.11b WLAN Utility (USB)
- 4 Wireless LAN & Bluetooth Modules

Wireless LAN Driver Installatio
1. Turn the Wireless Module ON/OFF sw
2. If you have two wireless modules, you

tion Fn + F12 to enable the Wireless L
cator  will be green - see “LED Po
Indicators” on page 2 - 6). If you only
go straight to step 3.

3. If the Found New Hardware Wizard ap
4. Insert the Wireless LAN CD-ROM int
5. The program will run automatically.
6. Click Next > Next > Yes > Next > Ne
7. Click Yes if you wish to add a shortcu

top.
8. Follow the instructions to install the A

not already have Adobe Acrobat Read
Anyway if asked if you want to contin

9. Click Finish and restart the computer.

The Wireless LAN User Manual is in Ad
point to Programs/All Programs > IEE
then select the User Manual).
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Bluetooth Driver Installation (Win2000)
1. Turn the Wireless Module ON/OFF switch ON.
2. If you have two wireless modules, you may need to use the key co

tion Fn + F12 to enable the Bluetooth module (the Mail LED ind
 will be orange - see “LED Power & Communication Indicato

page 2 - 6). If you only have the Bluetooth module go straight to s
3. If the Found New Hardware Wizard appears, click Cancel.
4. Insert the Bluetooth CD-ROM into the CD drive.
5. The program will run automatically.
6. If the Found New Hardware Wizard appears, click Cancel, and clic

if you see Unsafe Removal of Device. 
7. Click Start (menu) > Run...
8. Navigate (Browse...) to the top level of the CD D:\ and click OK.
9. Click Install Drivers and Application Software.
10. Click Next.
11. Click the button to accept the license agreement, then click Next.
12. Click Next > Install (click OK if asked if you want to continue).
13. Click Finish > Yes to restart the computer.
14. You can configure the settings in the Bluetooth Configuration co

panel (Start menu and point to Settings and click Control Panel 
double-click the Bluetooth Configuration icon).

The Bluetooth User’s guide (Manual) is on the Bluetooth CD-ROM
Userguide folder (click Browse this CD when you insert the Bluetoo
ROM). It is in .html format.
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Win2000)
dows 2000 you may no longer hear
 taskbar. If this is the case then fol-

ol Panel (Start Menu and point to 
ouble-click the Sounds & Multime-

cording menus choose Realtek 

at the tickbox to “Show volume 
- 6 Wireless LAN & Bluetooth Modules

Bluetooth Driver Audio Setup (
After installing the Bluetooth driver in Win
any sound, nor see the Volume icon in the
low this procedure:

1. Go to the Sounds & Multimedia Contr
Settings and click Control Panel then d
dia icon).

2. Click the Audio tab.
3. In the Sound Playback and Sound Re

AC97 Audio.
4. Click the Sounds tab and make sure th

control on the taskbar” is ticked.
5. Click OK.
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Bluetooth Driver Installation (WinXP)
1. Turn the Wireless Module ON/OFF switch ON.
2. If you have two wireless modules, you may need to use the key co

tion Fn + F12 to enable the Bluetooth module (the Mail LED ind
 will be orange - see “LED Power & Communication Indicato

page 2 - 6). If you only have the Bluetooth module go straight to s
3. If the Found New Hardware Wizard appears, click Cancel.
4. Insert the Bluetooth CD-ROM into the CD drive.
5. The program will run automatically.
6. Click Install Drivers and Application Software and click Next.
7. Click the button to accept the license agreement, then click Next.
8. Click Next > Install (click OK if asked if you want to continue).
9. When the Found New Hardware Wizard appears select “Install fr

list or specific location (Advanced)” then click Next.
10. Select “Search for the best driver in these locations.” and selec

ONLY “Include this location in the search:”.
11. Navigate (Browse...) to the top level of the CD D:\ and click OK >

> Finish (click Continue Anyway if asked if you want to continu
then restart the computer.

12. You can configure the settings in the Bluetooth Configuration co
panel (Start menu and point to Settings and click Control Panel 
double-click the Bluetooth Configuration icon).

The Bluetooth User’s guide (Manual) is on the Bluetooth CD-ROM
Userguide folder (click Browse this CD when you insert the Bluetoo
ROM). It is in .html format.
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el options after installing the Blue-

ngs and click Control Panel, then 
ces/Sounds & Multimedia icon 
Devices).
e “Default device:” is the Realtek 

ll Programs, then point to Acces-
minal.
e sure you have selected “Connect 

ngs and click Control Panel, then 
n (Category View > Printers and 

e Fax Console.
 “Configure Fax...”.
e fax device is the 56K MDC 
- 8 Wireless LAN & Bluetooth Modules

Control Panel Options (Bluetoo
You may need to change some control pan
tooth driver:

Audio
1. Go to the Start menu and point to Setti

double-click the Sounds & Audio Devi
(Category View > Speech, and Audio 

2. Click Audio (tab) and make sure that th
AC97 Audio.

Hyper Terminal
1. Go to Start menu and click Programs/A

sories > Communications > HyperTer
2. Double-Click your connection, and mak

Using:” 56K MDC Modem.

FAX (WinXP)
1. Go to the Start menu and point to Setti

double-click the Printers and Faxes ico
Other Hardware).

2. Double-click your fax icon to bring up th
3. Click the Tools menu and scroll down to
4. Click Next > Next and make sure that th

Modem.
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FAX (Win2000)
1. Go to the Start menu and point to Settings and click Control Panel,

double-click the Fax icon.
2. Click Advanced Options (tab) and click the Open Fax Service 

Management Console (button).
3. Click Devices in the Tree window on the left.
4. The fax devices will be displayed in the right window, with the device

the highest priority displayed at the top.
5. Select the 56K MDC Modem and use the arrows to move it to the top

priority list, then close the windows.
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era you will need to install the de-
ing pages (only install the drivers
hased). After installing the driver
ing to the PC Camera 301P item
nu and selecting the AMCAP pro-
- 10 PC Camera

PC Camera
If you have purchased the optional PC Cam
vice driver for it as indicated in the follow
for the optional modules you have purc
you can run the application software by go
in the Start > All Programs/Programs me
gram.
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PC Camera Driver Installation (Win2000)
1. Insert the PC Camera CD-ROM into the CD Drive.
2. Click Start (menu) > Run...
3. Navigate (Browse...) to D:\Default setting_60Hz\Setup.exe and 

OK.
4. Click Next (click Yes if asked if you want to continue at any time
5. Click Finish.
6. Restart the computer.
7. After restart the computer will either find the new hardware for yo

will bring up the Found New Hardware Wizard for the USB PC Ca
301P.

8. If you see the Found New Hardware Wizard follow the procedure 
otherwise go to step 13.

9. Click Next.
10. Select “Search for a suitable driver for my device (recommend

and click Next.
11. When Locate Driver Files appears, select ONLY “Specify a locat

and click Next.
12. Navigate (Browse...) to D:\Default setting_60Hz and click OK >

> Finish (click Yes if asked if you want to continue).
13. To run the application software go to the PC Camera 301P USB 

era item in the Start > Programs menu, and select the AMCAP p
gram (see “AMCAP” on page 7 - 15).
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(WinXP)
the CD Drive.

tting_60Hz\Setup.exe and click 

if asked if you want to continue at 

p the Found New Hardware Wiz-
you see the Found New Hardware 
USB) Controller appear first, 

ocation (Advanced)” then click 

 these locations.” and select 
earch:”.
tting_60Hz and click OK > Next 
sked if you want to continue).

 window to appear, then click Yes 

he PC Camera 301P USB Cam-
Programs menu, and select the 
 page 7 - 15).
- 12 PC Camera

PC Camera Driver Installation 
1. Insert the PC Camera CD_ROM into 
2. Click Start (menu) > Run...
3. Navigate (Browse...) to D:\Default se

OK.
4. Click Next (click Continue Anyway 

any time).
5. Click Finish.
6. Restart the computer.
7. After restart the computer will bring u

ard for the USB PC Camera 301P (if 
Wizard for the Universal Serial Bus (
click Cancel to close the window).

8. Click “Install from a list or specific l
Next.

9. Select “Search for the best driver in
ONLY “Include this location in the s

10. Navigate (Browse...) to D:\Default se
> Finish (click Continue Anyway if a

11. Wait for the System Settings Change
to restart the computer.

12. To run the application software go to t
era item in the Start > Programs/All 
AMCAP program (see “AMCAP” on
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Windows 2000 Audio 
Setup

Go to the Start menu
and point to Settings
and click Control Pan-
el then double-click the
Sounds and Multime-
dia icon.
Click Audio (tab) and
click Volume (button)
in the Sound Record-
ing menu.
Select Advanced
Controls from the Op-
tions menu.

(Continued overleaf.)
Audio Setup
If you wish to capture video & audio with your camera, it is necessary t
the audio recording options in Windows. To do this in Windows XP (fo
dows 2000 see sidebar):

1. Go to the Start menu and point to Settings and click Control Panel,
double-click the Sounds & Audio Devices icon (Category View > Sp
and Audio Devices).

2. Click Advanced in the Volume tab.
3. Click Options (Volume Control) and scroll down and click Properties
4. Click Recording (Adjust volume for) and click Microphone (check b

then click OK.
5. Make sure the Select (check box) in the Recording Control panel, u

the Microphone section, is checked (boost the volume as high as it w
6. Close the open windows.
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Windows 2000 Audio 
Setup (continued)

Make sure the Select
(check box) in the Mi-
crophone section is
checked, and boost
the volume as high as
it will go.

Close the windows.

Figure 7 - 1
Audio Setup 

(Windows XP)
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pted).

Pre-Allocating File 
Space

You may pre-allocate
the file size for the cap-
ture file in the AMCAP
program. You can
choose to ignore this
by clicking Cancel.

Pre-allocating space
on the hard disk can
improve the capture
quality (particularly of
large capture files), by
reducing the amount of
work the hard disk has
to do in finding space
for the video data as it
is being captured.

You may find it helpful
to defragment the HDD
before capture.
AMCAP
AMCAP is a video viewer useful for general purpose video viewing an
ing, and can capture video files to .avi format.
To capture video:
 

1. Run the AMCAP program from the Start > Programs menu (it is rec
mended that you set the capture file before the capture process - s
Capture File below).

2. Go to the Capture menu heading (if you wish to capture audio make
that the Capture Audio option is ticked) and select Start Capture.

3. On the first run of the program (if you have not set the captured file) y
be asked to choose a file name and size (see the sidebar - Pre-Allo
File Space) for the captured file. Click Start Capture again.

4. Click OK to start capturing the video, and press Esc to stop the captu
5. If you wish to, you may go to the File menu and select Save Capture

Video As..., choose a file name and location, then click Open (you ca
the file using the Windows Media Player).

Set Capture File
In the AMCAP program, you will only be asked to set the capture fil
on the first run of the program. When you run the program the next ti
file will automatically be overwritten with the newly captured file. To
overwriting files you can go to the Set Capture File.. option in the File
and set the file name and location before capture. Set the name and lo
then click Open (you can choose Cancel to ignore the file size if prom
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AP program is flickering, you can
pture Filter options.
t > Programs menu.
t “Video Capture Filter...”.
m the No Flicker box.
- 16 PC Camera

Eliminating Screen Flicker
If you find that the video screen in the AMC
try to adjust the option from the Video Ca
1. Run the AMCAP program from the Star
2. Go to Options and scroll down to selec
3. You can choose either 50Hz or 60Hz fro

Figure 7 - 2
Camera Controls
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g your service representative, you
mmon problems and their possible
ere before you panic. If you don’t
uctions carefully and observed the
resentative. You should also make

nient time possible, so you should
he system still won’t cooperate, try
nsaved data, but it may start work-
Chapter 8: Troubleshooting
Overview
Should you have any problems with your computer, before consultin
may want to try to solve the problem yourself. This chapter lists some co
solutions. This can’t anticipate every problem, but you should check h
find the answer in these pages, make sure you have followed the instr
safety precautions in the preface. If all else fails, talk to your service rep
a record of what happened and what remedies you tried.

Of course, if something goes wrong, it will happen at the most inconve
preview this section just in case. If, after you’ve tried everything, and t
turning it off for a few minutes and then rebooting. You will lose any u
ing again. Then call your service representative.
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8

 to a problem when your computer

al outlet? If plugged into a 
ower Indicators (see “LED 
computer’s power status.

o loose connections anywhere.

r Standby mode by pressing the 
), or by pressing the power but-

Fn + F8 and F9 keys to adjust 

et to “external only” display (see 

hen you start up your machine 
eplace the disk, and then press 
- 2 Basic Hints and Tips

Basic Hints and Tips
Many of the following may seem obvious but they are often the solution
appears not to be working. 

• Power - Is the computer actually plugged into a working electric
power strip, make sure it is actually working. Check the LED P
Power & Communication Indicators” on page 2 - 6) to see the 

• Connections - Check all the cables to make sure that there are n

• Power Savings - Make sure that the system is not in Hibernate o
Fn + F4 key combination (see “System Resume” on page 3 - 18
ton, to wake-up the system.

• Brightness - Check the brightness of the screen by pressing the 
the brightness (see “Advanced Video Controls” on page 3 - 2).

• Display Choice - Press Fn + F7 to make sure the system is not s
“Display Devices” on page 3 - 7).

• Boot Drive - Make sure there are no floppy disks in the drive w
(this is a common cause of the message “Invalid system disk - R
any key”).
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8

 and programs safe, but close to 
them out of their original cases, 

 as you can. You may schedule 
puter. You can use those that are 
 programs to do so.

r computer). This is especially 
(see “Security Menu” on page 5 

s, mail settings etc. (even if just 

ing the CPU in any way, may violate
Backup an

Backup and General Maintenance
• Always backup your important data, and keep copies of your OS

hand. Don’t forget to note the serial numbers if you are storing 
e.g. in a CD wallet.

• Run maintenance programs on your hard disk and OS as often
these programs to run at times when you are not using your com
provided free with your OS, or buy the more powerful dedicated

• Write down your passwords and keep them safe (away from you
important if you choose to use a Startup password for the BIOS 
- 12).

• Keep copies of vital settings files such as network, dialup setting
brief notes).

Warranty

The CPU is not a user serviceable part. Opening this compartment, or access
your warranty.
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 file which tells your program 
discovered daily, and some of 
ata. Anti-Virus programs are 
lly downloadable directly from 

iruses are often triggered from 
hed file. You can configure most 
u should also beware of files 
s book and been automatically 

n which allows you to startup 
n for instructions on how to 

h a disk (or at least instructions 
- 4 Viruses

Viruses
• Install an Anti-Virus program and keep the definitions file (the

which viruses to look for) up to date. New computer viruses are 
them may seriously harm your computer and cause you to lose d
commercially available and the definitions file updates are usua
the internet.

• Be careful when opening e-mail from sources you don’t know. V
within e-mail attachments so take care when opening any attac
Anti-Virus programs to check all e-mail attachments. Note: Yo
from people you know as the virus may have infected an addres
forwarded without the person’s knowledge.

• Keep a “Boot Floppy Disk” (this disk provides basic informatio
your computer) handy. You may refer to your OS’s documentatio
make one, and many Anti-Virus programs will also provide suc
on how to make one).
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8

oftware
unless you are very sure of what 
ystem.

ork if you are not comfortable 

 this that you are looking at the 
ou have just purchased? Many 
oftware. Always refer to the doc-
ular attention to files entitled 

ered on, and in many cases you 
s are correctly connected.

you have installed (latest driver 
Upgrading and Adding N

Upgrading and Adding New Hardware/S
• Do not be tempted to make changes to your Windows Registry 

you are doing, otherwise you will risk severely damaging your s

• Don’t open your computer or undertake any repair or upgrade w
with what you are doing.

• Read the documentation. We can assume, since you are reading
computer’s manual, but what about any new peripheral devices y
problems are caused by the installation of new hardware and/or s
umentation of any new hardware and/or software, and pay partic
“READ ME” or “READ ME FIRST”.

• When installing a new device always make sure the device is pow
will need to restart the computer. Always check that all the cable

• Make sure you have installed the drivers for any new hardware 
files are usually available to download from vendor’s websites).
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 as these changes may affect one 
o back and undo the change you 

n the easier the source of the 
evices plugged into its ports, and 
ine the cause of a problem. Try 
 all the peripheral devices 
ces and restarting where neces-
be time consuming.
- 6 Upgrading and Adding New Hardware/Software

• Thoroughly check any recent changes you made to your system
or more system components, or software programs. If possible, g
just made and see if the problem still occurs.

• Don’t over complicate things. The less you have to deal with the
problem may be found; Example - if your computer has many d
a number of programs running, then it will be difficult to determ
disconnecting all of the devices and restarting the computer with
unplugged. A process of elimination (adding and removing devi
sary) will often find the source of a problem, although this may 
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olution

ttery bay, make sure the battery is 
ry only allows it to go in one way). 

ry contacts.

mputer doesn’t start up immediately, 

s a Power Options scheme (see 
n page 3 - 16) check its settings. You 
 a lot of power.

he fan port is not blocked. If this 
 mode or turn it off for an hour. Make 
t sitting on a thermal surface (see 
using the correct adapter. 

r cold environment. Place the battery 
al temperature try again. The battery 

your service center for more details.

r light is broken.
Power

Problem Possible Cause - S

You turned on the power 
but it doesn’t work.

Battery missing / incorrectly installed. Check the ba
present and seated properly (the design of the batte
Make sure there’s nothing interfering with the batte

The Battery LED power 
indicator , is blinking 
orange.

Low Battery. Plug in the AC power source. If the co
turn it off then on again.

You are losing battery 
power too quickly.

The system is using too much power. If your OS ha
“Conserving Power (Individual Components)” o
may also be using a PC Card device that is drawing

The notebook feels too 
hot.

Make sure the notebook is properly ventilated and t
doesn’t cool it down, put the system into Hibernate
sure the vents aren’t blocked and the computer isn’
“Overheating” on page 1 - 16). Make sure you’re 

The battery pack will not 
charge.

The battery pack is exposed to an excessively hot o
in a suitable environment and after it returns to norm
may be bad and may need to be replaced, contact 

The battery pack will not 
charge and the charge 
indicator light is off.

The battery is already fully charged and the indicato
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8

C adapter to your computer.

e control may be turned down. Adjust 
he AC adapter.

ing recharged. Make sure the battery 
e reusing (see “Battery Information” 

rol Panel in Windows and re-enable 

f power. Turn off the unused device to 

olution
- 8 Power

A beeping sound is heard 
and the low-battery 
indicator is on.

The battery power is nearly used up. Connect the A

A beep isn’t heard when 
the low-battery indicator 
turns on, or the gauge 
indicates power is less 
than 10%.

The battery power is nearly used up and the volum
the volume control and connect the computer with t

Actual battery operating 
time is shorter than 
expected.

The battery has not been fully discharged before be
is fully discharged and recharge it completely befor
on page 3 - 20).
Power Options have been disabled. Go to the Cont
the options.
A peripheral device or PC Card is consuming a lot o
save power.

Problem Possible Cause - S
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olution

uch the TouchPad.

leep/resume key combination, Fn + F4 
age 2 - 19).
 screen control key combinations Fn + 
u’re connected to an external monitor, 
 also check the monitor’s own 

e screen display key combination, Fn 
external monitor is connected, turn it 
Display

Problem Possible Cause - S

Nothing appears on 
screen.

The screen saver is activated. Press any key or to

The system is in a power saving mode. Toggle the s
(see “Function Keys and Numeric Keypad” on p
\

The screen controls need to be adjusted. Toggle the
F8/F9 (see “Opening the LCD” on page 3 - 2). If yo
make sure it’s plugged in and turned on. You should
brightness and contrast controls.
The computer is set for a different display. Toggle th
+ F7 (see “Display Devices” on page 3 - 7). If an 
on.
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8

nal monitor. Avoid using the 
only. Switch to a lower resolution and/
 the display controls (see “Vertical 

ition of the LCD. LCD’s are designed 
 may see glare from the screen’s 

ean dry cloth. Many cleaning solutions 
he precautions outlined in the Preface. 
anest hands can leave oils which 

 display options. Press the Fn + F7  

d it appropriately from the Control 
tructions on installing the driver, and 
ge 3 - 4 for instructions on configuring 

olution
- 10 Display

The screen is flickering, 
or the images aren’t 
clear.

The vertical refresh rate is insufficient on your exter
Simultaneous display mode. Use LCD only or CRT 
or fewer colors, and adjust the refresh frequency in
Refresh Rate” on page 3 - 7).
The viewing angle of the LCD is bad. Adjust the pos
to be viewed “straight on”. If the angle is wrong, you
backlight.
The screen is dirty. Clean the screen using a soft, cl
can damage the LCD surface so you should follow t
Try to avoid touching the screen itself. Even the cle
attract contaminants.

No image appears on the 
external monitor I have 
plugged in and powered 
on.

You haven’t used the key combination to switch the
key combination to toggle through the options.
You haven’t installed the video driver and configure
Panel. See “What to Install” on page 4 - 2 for ins
see “Making Adjustments for the Display” on pa
the video driver.

Problem Possible Cause - S
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olution

maged. Operate the scan disk or disk 
.
e.

olution

rge the battery of the CMOS. Contact 

es of this could be serious. If you cannot
e information on your hard disk.
Hard D

Hard Disk & Boot Password

Problem Possible Cause - S

The computer takes 
longer during Startup.

Data saved on the hard disk drive may be lost or da
defragmenter to check for any lost or damaged data
The computer is waking up from the Hibernate mod

Problem Possible Cause - S

You forget the boot 
password.

If you forget the password, you may have to discha
your service representative for help.

Password Warning
If you choose to set a boot password, NEVER forget your password. The consequenc
remember your boot password you must contact your vendor and you may lose all of th
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olution

u may do this by right-clicking the disk 
mat from the menu). Bear in mind that 

rm data storage, and have a finite life 
 for a long time on floppy disks. As a 
ularly.
ion by moving the write-protect tab on 

 disk. Use a new disk or delete any 

py disk. Remove the floppy and insert 
u will need to restart the computer.
- 12 Floppy Disk Drive

Floppy Disk Drive

Problem Possible Cause - S

The floppy disk drive will 
not write data to disk.

The floppy disk is not formatted. Format the disk (yo
icon in My Computer in Windows and choosing For
this will erase all data contained on the floppy disk.
Note: Floppy disks were never intended for long-te
span. Do not store important files you wish to keep
general rule it is worth reformatting floppy disks reg
The floppy disk is write-protected. Undo the protect
the disk down until it clicks.
There is not enough unused space available on the
unneeded data.

The message “Invalid 
system disk - Replace 
the disk, and then 
press any key” appears.

The computer is trying to boot from an incorrect flop
a correct one, or boot from your hard disk or CD. Yo
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olution

 control in the Volume Control Panel 
 Fn + F5 and F6 (see “Function Keys 

ould be plugged into the headphone-
11).

 2000

any sound, nor see the Volume icon

ettings and click Control Panel then

C97 Audio.
ntrol on the taskbar” is ticked.
Audio

Problem Possible Cause - S

The sound cannot be 
heard or the volume is 
very low.

The volume might be set too low. Check the volume
in the Windows taskbar, or use the key combination
and Numeric Keypad” on page 2 - 19) to adjust.
The headphone is plugged into the wrong jack. It sh
out jack (see “Headphone-Out Jack” on page 1 - 

Bluetooth Driver & Audio Setup in Windows

After installing the Bluetooth driver in Windows 2000 you may no longer hear 
in the taskbar. If this is the case then follow this procedure:
1. Go to the Sounds & Multimedia Control Panel (Start Menu and point to S

double-click the Sounds & Multimedia icon).
2. Click the Audio tab.
3. In the Sound Playback and Sound Recording menus choose Realtek A
4. Click the Sounds tab and make sure that the tickbox to “Show volume co
5. Click OK.
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olution

leaner kit.

Gently try to remove the disc using the 

 See “DVD Regional Codes” on 

software. Refer to your operating 
 and make sure you have the correct 

f the proper software is installed and a 
ut a possible hardware problem.

OM drive, or the CD-ROM drive is not 
 the CD-ROM drive properly installed 

 cleaner kit.
software. If the correct software is 
t a hardware problem.
- 14 CD Device

CD Device

Problem Possible Cause - S

The compact disc cannot 
be read.

The compact disc is dirty. Clean it with a CD-ROM c

The compact disc tray 
will not open when there 
is a disc in the tray.

The compact disc is not correctly placed in the tray. 
eject hole (see “Loading Discs” on page 2 - 12).

The DVD regional codes 
can no longer be 
changed.

The code has been changed the maximum 5 times.
page 2 - 14.

A music compact disc 
can be read while a data 
disc can not.

There may be a problem with the disc hardware or 
system manual for more information on the software
software installed for running video compact discs. I
problem still exists, contact your service center abo

All compact discs cannot 
be read.

The Windows system does not recognize the CD-R
compatible with other devices. Make sure you have
and configured.
The CD-ROM drive is dirty. Clean it with a CD-ROM
There may be a problem with the disc hardware or 
properly installed, contact your service center abou
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olution

ted incorrectly. Remove the card and 
the card in until it locks into place.

e computer. Check “PC Card” on 

 (see “What to Install” on page 4 - 2).

ed. Please read the documentation 
re you install any drivers, if they are 
y extra functions which come with the 
PC Card

Problem Possible Cause - S

The system cannot 
recognize the PC Card.

The PC Card is not inserted into the socket or inser
re-insert it aligning the PC Card with the slot. Push 

The PC Card or card driver is not compatible with th
page  A - 3 to check the compatibility of the card.

The PC Card driver is not installed. Install the driver

The system cannot access the card after it is install
which comes with any new external device. Make su
supplied with it, as this will allow you to access an
device.
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. Press and release the Fn + NumLk 

 functions. Make sure you read the 
device, and make sure you install the 
 functions which come with your 

ny standard PS/2 or USB keyboard.
/hot keys unique to the system’s reg-
- 16 Keyboard and Mouse

Keyboard and Mouse

Problem Possible Cause - S

Unwelcome numbers 
appear when typing.

If the LED  is lit, then Number Lock is turned ON
key combination.

I have installed a new 
external keyboard or 
mouse but cannot use all 
of the listed functions.

You have not installed the driver to enable any extra
documentation which comes with any new external 
driver for it as this will allow you to access any extra
device.

Other Keyboards
If your keyboard is damaged or you just want to make a change, you can use a
The system will detect and enable it automatically. However special functions
ular keyboard may not work.
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olution

ted to the computer, or has an internal 
nections and cables and then try to 
nual for instructions on printing a “self-
computer connections and is a means 

rect for the settings designated in your 
 paper to make sure it doesn’t stick 
er size matches your software’s “print” 

correctly. Check that the printer is 
 Also check that you have installed the 
rs are usually available for download 

 connected to the network. All 
 with your network administrator to 
Printer

Problem Possible Cause - S

The printer cannot be 
added to the system or 
will not work.

The printer is not turned on, is not correctly connec
problem. Make sure the printer is on. Check all con
reinstall the driver. You may refer to the printer’s ma
test” page (a “self-test” page will print regardless of 
of ensuring that the printer is actually working). 

There is no paper in the printer, or the paper is incor
software. Put more paper in the printer (also fan the
together and cause a paper jam) and check the pap
settings.

The printer driver is not installed or is configured in
properly installed and configured (correct port etc.).
latest driver compatible with your OS (updated drive
from the printer manufacturer’s website).

The printer is a network printer and it is not properly
networks are configured differently so please check
get the correct setup.
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t. Use the AC adapter, press the sleep 
n if no LEDs are lit.
lt your OS manual. As a last resort, 
he system or if that doesn’t work, turn 

er Options control panel in your OS 

e Power Options presets.

ed. Read the documentation which 
 install the driver (if one is required) 
ions which come with your device.

onfiguring the Infrared Settings for 
ared device in the BIOS (see “I/O 
e 5 - 11) are for the FIR setting.
ing is between your system’s infrared 
d transceivers operate on a “Line of 
- 18 Operation

Operation
Problem Possible Cause - S

The system freezes or 
the screen goes dark.

The system’s power saving features have timed-ou
(Fn + F4) key combination, or press the power butto
A software conflict made the system “crash”. Consu
since you will lose any unsaved data, try to reboot t
the computer off and on again.

The system never goes 
into Hibernate mode.

Make sure you have enabled Hibernate in the Pow
(see “Hibernate” on page 3 - 18).

The system does not go 
into a power saving 
mode when the battery is 
low.

No power saving options are enabled. Use one of th

The infrared device does 
not work.

The drivers (if supplied with the device) are not load
comes with any new external device. Make sure you
for it as this will allow you to access any extra funct
The FIR settings are not configured correctly. See “C
FIR” on page 3 - 22. Check the settings for the infr
Device Configuration (Advanced Menu)” on pag
The infrared transceiver is blocked. Make sure noth
transceiver and the destination’s transceiver. Infrare
’Sight”.
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olution

. Make sure you have set the ON/OFF 
ireless LAN & Bluetooth Modules” 

t you have both the Wireless LAN and 
12 key combination to toggle power to 

 use both modules at the same time as 

led. Make sure you have installed the 
N & Bluetooth Modules” on page 7 

elp you configure them:
mat (Start menu and point to 
ser Manual).
tooth CD-ROM in the Userguide 

luetooth CD-ROM). It is in .html 
Wireless LAN

Wireless LAN & Bluetooth Modules
Problem Possible Cause - S

The Wireless LAN or 
Bluetooth module cannot 
be detected.

The ON/OFF switch  has not been switched ON
switch to ON in order to enable the module (see “W
on page 7 - 2). 

The ON/OFF switch  has been switched ON, bu
Bluetooth modules in your computer. Use the Fn + F
the modules. DO NOT enable power and attempt to
this may cause a conflict.

The Wireless LAN or 
Bluetooth module cannot 
be configured.

The driver(s) for the module(s) have not been instal
driver for the appropriate module (see “Wireless LA
- 2).

Both modules come with User Guides/Manuals to h
The Wireless LAN User Manual is in Adobe .pdf for
Programs > IEEE 802.11b WLAN Utility(USB) > U
The Bluetooth User’s guide (Manual) is on the Blue
folder (click Browse this CD when you insert the B
format.



Troubleshooting

8

8

olution

tions. Make sure that you do not 
 the drivers in Windows XP. 

ted in “What to Install” on page 4 - 2.
- 20 Driver Installation

Driver Installation
Problem Possible Cause - S

There is a problem 
installing the Audio 
drivers in Windows XP.

You have enabled Windows XP Multi Language Op
enable any Multi Language Options when installing

Make sure you install the drivers in the order indica
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 the Advanced Menu in the BIOS
per-Threading is only supported in
is Processor the menu option will

able this option if you are using

ch did not have the Enable Hyper-
date. 

n or the computer may not startup
e of accidental disabling of the op-

Threading, to one which does not,
H

Hyper-Threading Notes
You can enable (the default setting is disabled) Hyper-Threading from
(see “CPU Hyper-Threading (Advanced Menu)” on page 5 - 10). Hy
Model C computers with 3.06GHz processors. If you do not have th
not appear.

Hyper-Threading is only supported in Windows XP, so DO NOT en
Windows 2000. 

If you have updated the Flash ROM BIOS from a previous version, whi
Threading option, you must reinstall Windows XP after the BIOS up

Once you have enabled Hyper-Threading, DO NOT disable the optio
(returning to the BIOS and enabling the option will correct this in cas
tion).

If you are changing the processor from a CPU which supports Hyper-
you will need to reinstall your OS.
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A

rocessor - (478-pin) FC-PGA2 

icron Process Technology, 128KB 
0MHz FSB - 1.7/ 1.8 /2.0 / 2.1 /2.2 

+ 962 Chipset +P9-M

nt
Appendix A. Specifications
Processor
• Intel Pentium 4 Processor

(µ0.13) 0.13 Micron Process Technology, 512K L2 
Cache & 400MHz FSB - 2.0/ 2.2/ 2.4/ 2.5/ 2.6GHz 
- FC-PGA2 package (478-pin)   

(µ0.13) 0.13 Micron Process Technology, 512K L2 
Cache & 533MHz FSB - 2.26/ /2.53/ 2.66/ 2.8/
3.06* GHz - FC-PGA2 package (478-pin) 

* Only notebooks with Pentium 4 processors of
3.06GHz support Hyper-Threading (see “CPU
Hyper-Threading (Advanced Menu)” on page 5 -
10).

• Intel Celeron P
package

((µ0.18) 0.18 M
L2 Cache & 40
GHz

Core Logic
• SIS M645DX 

Structure
• PC99 complia



A

A

s
TFT (1024*768)
TFT (1024*768)

+ TFT (1400*1050)

adeon 9000 high performance chip
TM 4X
-bit 2D / 3D Graphics Accelerator
 accelerator for DVD playback
 8.0 compliant graphics engine
ory up to 64MB DDR SGRAM on 

play monitor
 - 2

Security
• Security (Kensington® Type) Lock
• BIOS Password

Memory
• Two 200-pin DDR SODIMM sockets, support-

ing DDR SDRAM SODIMM (2.5V) - DDR 200/ 
DDR 266/ DDR 333 compliant

• Memory expandable up to 1024MB (128/256/
512MB SODIMM Modules)

BIOS
• One 512KB Flash ROM
• Phoenix BIOS

LCD Option
• 14.1" XGA 
• 15.0" XGA 
• 15.0" SXGA

Display
• ATI Mobility R
• Supports AGP
• Integrated 128

Advanced HW
Fully Direct X

• External mem
board

• Dual-View dis
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yboard

MCIA 3.3V/5V socket supporting 
Storage Devices
• 3.5" 3-mode Floppy Disk Drive

• Easy changeable 2.5" 9.5 mm (h) Hard Disk 
Drive 
Supports Master mode IDE
Supports PIO mode 4
ATA-33/66/100/133
Ultra DMA

• 12.7mm(h) Device Bay for ONE of the 
following drive configuration options:
CD-ROM
DVD-ROM
CD-RW
Combination CD-RW/DVD-ROM
DVD-RW

Audio
• AC'97 2.1 com
• 3D stereo enha
• Compatible w
• S/PDIF Digita

and stereo aud
• Microphone-in
• Headphone-ou
• Built-in micro
• 2 built-in spea

Keyboard
• “Win Key” ke

PC Card
• One type II PC

CardBus
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Interface
• Built-in TouchPad (scrolling key functionality 

integrated) 
• Three USB 2.0 ports
• One Mini-IEEE 1394 port
• One S-Video Out port for TV output
• One serial port
• One parallel port (LPT1), supporting ECP / EPP
• One infrared transceiver supporting IrDA 1.1/

FIR/SIR/ASKIR
• One external CRT monitor port
• One external keyboard/mouse (through Y cable) 

PS/2 port
• One speaker-out/headphone-out jack
• One microphone-in jack
• One RJ-11 jack for modem
• One RJ-45 jack for 100M/10M LAN
• One S/PDIF out port
• One DC-in jack
• Wireless module On/Off switch

Communica
• Wireless Infra

1cm - 1M ope
4Mbps FIR

• Built-in 10/10
• 56K MDC mo
• 802.11b wirele

factory option
• Bluetooth mod
• PC Video Cam

option)

Power Mana
• Supports ACP
• Supports Hibe
• Supports Stand
• Supports Batte
• Supports resum
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Power
• Full range AC adapter

AC-Input 100~240V, 50~60Hz
DC Output 20V, 6A (120W)

• Supports one removable Smart Li-Ion battery 

Indicators
• LED indicators (Power On/ AC-In/ Suspend, 

Battery Charging/Battery Full, E-Mail, HDD, 
Num Lock, Caps Lock, Scroll Lock)

Environmental Spec
• Temperature

Operating: 5°C ~ 35°C 
Non-Operating: -20°C ~ 60°C

• Relative Humidity
Operating: 20% ~ 80%
Non-Operating: 10% ~ 90%

Physical Dim
• 329 (w) x 275

Weight
• 3.3 kg with ba

Optional
• DVD-ROM D
• CD-RW Drive
• Combination D
• DVD-RW Dri
• Software DVD
• Wireless LAN
• Bluetooth mod
• PC Video Cam
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